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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2005- 2006 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a US trademark of Sun Microsystems, Inc.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

Microsoft®, Windows NT®, and Windows® are U.S. registered trademarks of Microsoft Corporation.  
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP OpenView Support web site at:

www.hp.com/managementsoftware/support 

HP OpenView online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

www.managementsoftware.hp.com/passport-registration.html 
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1 OAS SPI Concepts
The Smart Plug-in for Oracle Application Server (OAS SPI) allows you to manage Oracle 
Application Servers from an HP OpenView Operations (OVO) console. OAS SPI adds 
monitoring capabilities otherwise unavailable to OVO. For more information on OVO refer to 
HP OpenView Operations for UNIX  Concepts Guide.

This chapter offers a basic introduction to its concepts. The following topics are covered:

• Introducing the OAS SPI

• Functions of OAS SPI

• Components of OAS SPI

Introducing the OAS SPI

The OAS SPI adds monitoring capabilities otherwise unavailable to OVO.

Smart Plug-in Integration Uses

Used in conjunction with OVO, the OAS SPI offers centralized tools that help you monitor and 
manage systems using Oracle Application Server. From the OVO console, an operator can 
apply the same familiar HP OpenView performance and problem managing processes to 
monitor a system using Oracle Application Server. OAS SPI metrics are automatically sent to 
the OVO agent and can be alarmed on, and/or consolidated into reports and graphs which 
help you analyze trends in server usage, availability, and performance. OAS SPI can be 
integrated with HP OpenView Reporter and HP OpenView Performance Manager (both 
products must be purchased separately) to provide additional reporting and graphing 
flexibility and capabilities.

Smart Plug-in Data

After completing the OAS SPI installation, you can find key server-related metrics that cover 
the following areas:

• server availability

• server performance

• JVM memory usage

• EJB client and method wrapper active threads, execution times, and calls processed

• servlet execution times and threads

• JSP service time and active requests

• Java message service connections and messages
13



• JDBC connection status

• Web application processing and open sessions

• HTTP server active connections and processed data

Smart Plug-in Uses and Customizations

Oracle Application Server administrators can choose those metrics that are most crucial to 
the successful operation of Oracle Application Server by modifying OAS SPI templates. The 
templates contain settings that allow incoming data to be measured against predefined rules 
that generate useful information in the form of messages. These messages with severity-level 
color-coding can be reviewed for problem analysis and resolution. Corrective actions that are 
pre-defined for specific events or threshold violations can be automatically triggered or 
operator-initiated.

Functions of OAS SPI

OAS SPI messaging, reporting, and action-executing capabilities are based on the OVO 
concept of templates; for more information refer to HP OpenView Operations for UNIX  
Concepts Guide. The settings within these templates define various conditions within the 
Oracle Application Server. Once in use, OAS SPI templates allow information to be sent back 
to the OVO management server to help you proactively address potential or existing problems 
and avoid serious disruptions to Web transaction processing. OAS SPI performs the following 
functions:

• Collecting and Interpreting Server Performance and Availability Information

• Displaying Information

• Generating Reports Using HP OpenView Reporter

• Graphing Data with OpenView Performance Manager

• Customizing Templates

Collecting and Interpreting Server Performance and Availability Information

OAS SPI, once configured and deployed to managed nodes, gathers data that is interpreted 
and acted upon, according to settings within the deployed templates. Those templates define 
conditions that can occur within the Oracle Application Server, such as throughput rates and 
execution times. Default thresholds, set within the templates, monitor these conditions and 
trigger messages to the console when a threshold has been exceeded.
14 Chapter 1



Displaying Information

• Messages in the Message Browser - Comparing the values gathered for Oracle 
Application Server performance/availability against the schedule template settings 
relating to those specific areas, OVO agent software forwards the appropriate messages to 
the OVO console. These messages are displayed with color-coded severity levels in the 
OVO Message Browser. 

• Instruction Text - Messages generated by OAS SPI programs contain instruction text to 
help diagnose and remedy problems. Corrective actions that are preassigned to events can 
be triggered automatically or manually by an operator.
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Instruction text, when available, can be found in the message details. This same text is 
also available in the HP OpenView Smart Plug-in for Oracle Application Server Reference 
manual metric definition.

• ASCII-Text Reports - In addition to the instruction text mentioned above, some 
messages cause automatic action reports to be generated. These reports show conditions 
of a specific Oracle OC4J/OHS server instance. When a report is available, like the 
instruction text, you can find it within the Message Details (in the Annotations area). 

Generating Reports Using HP OpenView Reporter

The OAS SPI also integrates with HP OpenView Reporter to provide you with 
management-ready, Web-based reports. OAS SPI includes the templates for generating these 
reports within its Report package, which you can install on the Reporter Windows system. 
After you have installed the product and completed some configuration steps, you can expect 
to see new reports of summarized, consolidated data generated nightly that help you assess 
how the Oracle OC4J/OHS server is performing over time.

Graphing Data with OpenView Performance Manager

OAS SPI can be used with HP OpenView Performance Manager (OVPM) to generate graphs 
(using the OASSPI Admin  J View Graphs application) showing the OAS SPI collected metric 
values. OVPM also allows you to view OAS SPI graphed data from most OAS SPI alarm 
messages by clicking Perform Action. Perform Action is available in both the Message Browser 
and in the message details (access details by either double-clicking the message or clicking 
Details...) in the Message Browser. The action launches your Web browser, where you can 
choose a graph that shows values for the metric that generated the message as well as other 
related metrics. 
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Customizing Templates

You can use OAS SPI templates with no customization, or you can change them as you find 
necessary. Minor modifications and major customizations are listed here:

• Modify the Default Templates - Within a template you can change the default settings for:

— collection interval

— threshold

— message text

— duration

— severity level of the condition

— actions assigned to the condition (operator-initiated or automatic)

• Create Custom Template Groups - Create custom template groups, using default 
templates as a starting point. For more information, refer to Chapter 4, Using and 
Customizing OAS SPI. 

Components of OAS SPI

The OAS SPI components include applications (including reports) and templates that allow 
you to configure and receive data in the form of messages, annotations, and metric reports. 
These messages (available in the Message Browser), annotations (available through message 
properties) and metric reports (available through applications or message details) provide you 
with information about conditions present in the servers running on specific managed nodes. 

OAS SPI configuration applications let you configure the management server’s connection to 
named server instances on specific managed nodes. After you have configured the connection, 
you can assign templates to the nodes. With OVO agent software running on the managed 
nodes, you can use OAS SPI reporting applications to generate metric reports. In addition, 
you can generate graphs that show OAS SPI data (available through message properties). 

 Applications

The OAS SPI applications include configuration, troubleshooting, and report-generating 
utilities. In the Application Bank window the OAS SPI applications are divided into three 
categories: OASSPI Admin, OracleAS, and OASSPI Reports. 
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OASSPI Admin Applications

OASSPI Admin applications allow you to configure, control, and troubleshoot the OAS SPI.  

The group contains the following applications (additional information about each application 
is located in Appendix C, Applications):

• Configure OASSPI - Launches the configuration editor and maintains the OAS SPI 
configuration.

• Discover OracleAS - Sets basic configuration properties needed for discovery.

• Init Non-Root - Simplifies the configuration of a non-root HTTPS agent on a UNIX 
managed node (OVO 8.x only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX 
Managed Node (OVO 8.x Only) on page 56 for all the steps necessary to configure a 
non-root HTTPS agent on a UNIX managed node.

• Self-Healing Info - Collects data to be sent to your HP support representative.

• Start/Stop Monitoring - Starts/stops the collection of metrics for one OC4J/OHS server or all 
OC4J/OHS servers on a managed node. 

Run the Verify application to determine if monitoring is started or stopped. By default, 
monitoring is on.

• Start/Stop Tracing - Starts/stops the tracing of the collection of metrics into a file. Run this 
application only when instructed by your HP support representative.

• Verify - Verifies that the OAS SPI is properly installed on the server or managed node. 

• View Error File - View the contents of the OAS SPI error log file. 

• View Graphs - View OAS SPI metric data in OpenView Performance Manager in a web 
browser (additional setup is required: see Task 1: Configure the Management Server to 
Launch your Web Browser on page 41 for more information).

OracleAS Applications

The applications in this group provide you with convenient access to Oracle Application 
Server functions. 
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You can open the Oracle applications by double-clicking OASSPI J OracleAS in the Application 
Bank window. 

The group contains the following:

• Launch Oracle AS Console - Allows the OpenView Operations user to launch the Oracle 
Application Server Control Console, launch the AggreSPY servlet, or launch the Oracle 
Enterprise Manager Database Control (requires setup).

• Start/Stop OracleAS - Allows the OpenView Operations user to start/stop the Oracle 
Application Server (requires setup).

• View OAS Logs - Allows the OpenView Operations user to view the Oracle Application 
Server log file(s).

• View Status - Does an interactive status check of the Oracle Application Server.

OAS SPI Reports

OAS SPI reports show information on Oracle Application Server conditions in the server. You 
generate these reports manually by dragging the managed node onto the report in the report 
application. Each report reflects shows the condition of all configured server instances on the 
managed node in relation to the metric. 
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OAS SPI Application Bank Reports

You can generate a report on all servers of a managed node by dragging the node onto a report 
in the Application Bank window

Application Bank Reports Generated from Alarms

An OASSPI Report can also be triggered by an alarm condition. When such a situation occurs, 
the report is generated automatically. This report is context sensitive, relating only to a single 
server on the managed node. You can find the report within the Annotations of a message. 

If you have configured your Message Browser to display the S column, a flag under the S 
column (adjacent to the message) indicates that the report was successfully generated and is 
waiting in the Annotations of the message.

Template Groups and Templates

OAS SPI template groups provide a means of organizing various OVO templates.  
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The primary SPI for OracleAS template group contains the following template groups and 
individual templates:

• OASSPI-Logfiles - Contains templates that generate messages according to log file and 
error text detected in both the Oracle Application Server log files and in the OAS SPI log 
files. The information captured from these log files includes errors that occur in the 
operation of the Oracle Application Server or the OAS SPI and changes to Oracle 
Application Server configuration.

• OASSPI-Metrics - Contains metric templates that monitor the performance levels and 
availability of a Oracle OC4J/OHS servers.

Each metric template determines the threshold conditions for the monitored metric, the 
message text that is sent to the OVO message browser when the threshold is exceeded, 
the actions to execute, and instructions that appear.

• OASSPI-Schedule - Contains collector templates that specify the collection interval of 
metric templates. Within the name of each collector template is its collection interval. For 
example, the collection interval of template OASSPI-10-OHS-15min is 15 minutes (where 
15min represents 15 minutes). Collector templates are assigned a collection interval of 5 
minutes, 15 minutes, or one hour.

When you open any collector template, you see the metrics collected within the interval 
(listed by number, following the -m option of the collector/analyzer command 
wasspi_oas_ca).

Each collector template controls when and what metrics are collected. Specifically, the 
collector template does the following: 

— Runs the collector/analyzer at each collection interval

— Specifies which metrics are collected

• OASSPI-Messages - A single template that is used to intercept OAS SPI messages for 
the OVO message browser.

• OASSPI-Discovery - A single template that updates the configuration on the OVO 
management server and managed nodes.

In the message browser shown above, all the messages are generated by OAS SPI templates 
that belong to the OracleAS and OASSPI Message Groups (see the column titled MsgGroup), 
indicating their origins. The OracleAS messages indicate conditions occurring in Oracle 
OC4J/OHS servers while the OASSPI message indicates a condition occurring in the OAS 
SPI.
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2 Installing, Upgrading, and Removing OAS SPI
This chapter covers installing and removing the Smart Plug-in for Oracle Application Server 
(OAS SPI) components for use with OpenView Operations.

The sections that follow provide instructions for:

• Installing OAS SPI

• Upgrading OAS SPI

• Removing OAS SPI

Installing OAS SPI

For a complete list of software requirements, refer to the HP OpenView Smart Plug-in for 
Oracle Application Server Release Notes.

The instructions that follow show the command line usage of swinstall. For HP-UX systems, 
you can also use the graphical user interface (GUI), but the GUI method is not covered.

For an HP-UX 11.0 management server, enter:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.sdtape OASSPI

For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape OASSPI

OAS SPI Filesets

The swinstall commands in the previous section install filesets for all managed node 
platforms. If you have managed nodes running on only one platform, you may want to install 
the filesets only necessary for the platform you have. Instead of specifying “OASSPI” on the 
swinstall command, you can specify the filesets listed below. 

It is not necessary to stop OVO sessions before beginning the OAS SPI installation.

Platform Filesets Description

HP-UX OASSPI-HPUX Fileset required for a managed node running on 
HP-UX.
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Upgrading OAS SPI

When you upgrade from a previous installation, all your configuration entries are preserved.

To upgrade OAS SPI, complete these tasks:

• Task 1: Remove OAS SPI Software from the Management Server

• Task 2: Delete OAS SPI Templates

• Task 3: Delete OAS SPI Applications

• Task 4: Upgrade the Management Server

• Task 5: Assign Operator Responsibilities for opc_adm

• Task 6: Assign Templates

• Task 7: Distribute Templates

• Task 8: Customize Templates

• Task 9: Move Nodes to New Node Group (Verify)

• Task 10: Delete Oracle Application Server Node Group

• Task 11: Distribute Actions, Monitors, Commands, and Templates

• Task 12: Launch the Discover OracleAS Application

• Task 13: Install the New Report Package (Optional)

• Task 14: Install the New Graph Package (Optional)

Task 1: Remove OAS SPI Software from the Management Server

To remove OAS SPI software from the management server follow these steps:

1 Open a terminal window and log on as root.

2 Run the following commands:

/usr/sbin/swremove OASSPI
/usr/sbin/swremove SPIOracleASAll
/usr/sbin/swremove OASSPI-GRAPHS 

3 Run the following command to delete all the SPI files in the /opt/OV/wasspi/oas/bin/ 
directory

Linux OASSPI-LXx86 Fileset required for a managed node running on 
Linux.

Solaris OASSPI-SOL Fileset required for a managed node running on 
Solaris.

Windows OASSPI-NT Fileset required for a managed node running on 
Windows.

Platform Filesets Description
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cd /opt/OV/wasspi/oas/bin
find . -name “wasspi_oas*” -exec rm {} \;

This deletes all files that begin with wasspi_oas.

Task 2: Delete OAS SPI Templates

Delete all OAS SPI templates and template groups that appear under the
SPI for Oracle AS template group and then delete the SPI for Oracle AS template group. If 
you have customized any of the default templates, note these changes (the customizations are 
not saved). Follow these steps:

1 From the windows menu select Message Source Templates and select the SPI for Oracle AS 
template group.

2 Double-click SPI for Oracle AS. All the template groups and individual templates in the 
group appear. 

3 Click OASSPI- Logfiles to open the individual templates in that group. Press Ctrl and click 
to select all the templates.

4 Click Delete From All... The following message appears:

Do you really want to delete the template(s)?

5 Click Yes.

6 Go up a level and open the next group. Repeat steps 2-5 till you delete all OAS SPI 
individual and group templates in the Message Source Template window. 

Task 3: Delete OAS SPI Applications

To delete OAS SPI applications, follow these steps:

1 Open the Application Bank.

2 Right-click the OASSPI application group and click Delete. The following message 
appears:

Do you really want to delete the application group?

3 Click Yes.

Task 4: Upgrade the Management Server

The OAS SPI software is available on the HP OpenView Smart Plug-ins for OVO/UNIX DVD. 

For an HP-UX 11.0 management server, run:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.sdtape OASSPI

For a Solaris management server, run:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape OASSPI

The instructions that follow show the command line usage of swinstall. For HP-UX systems, 
you can also use the graphical user interface (GUI), but the GUI method is not covered.
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Task 5: Assign Operator Responsibilities for opc_adm

To assign operator responsibilty for opc_adm follow these steps:

1 Log on to OVO as administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and click Modify.

3 In the Modify User:opc_adm user window, click Responsibilities. 

4 For OASSPI and OracleAS Message Groups, ensure that all check boxes are selected.

5 Assign the OASSPI Node or Message Groups to some other appropriate operators.

6 Click Close.

Task 6: Assign Templates

To assign the OASSPI-Discovery and OASSPI-Messages templates to the management server 
follow these steps:

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents J Assign Templates. The Define Configuration 
window opens.

3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 In the Template Groups pane, select the SPI for Oracle Server template group.

6 From the Message Source Templates window, in the right pane, select the 
OASSPI-Discovery template and OASSPI-Messages template.

7 From the Add Configuration window, click Get Template Selections. The OASSPI-Messages 
and OASSPI-Discovery templates appear in the right pane.

8 From the Add Configuration window, click OK.

Task 7: Distribute Templates

To distribute the OASSPI-Discovery and OASSPI-Messages templates to the management 
server, follow these steps: 

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents J Install/Update SW & Config. 

3 In the Target Nodes section, select Nodes in List Requiring Update.

4  In the Install/Update Software and Configuration window select the Templates check box.

5 Select Force Update.

6 Click OK.

The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates
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Task 8: Customize Templates

To customize the templates follow these steps:

1 Copy the default templates.

2 Apply the customizations made to the previous version of templates to the copy of the 
current version.

Task 9: Move Nodes to New Node Group (Verify)

Move all managed nodes (running supported versions of the Oracle Application Server) in the 
Oracle AS node group to the new Oracle AS node group. Follow these steps:

1 Open the Node Bank and double click Oracle AS node group.

2 Note the managed nodes in it. 

3 Go back to the top level of the node bank (where the Oracle AS node group is displayed)

4 Drag and drop or copy and paste the nodes (noted in step 2) from the IP submap to the 
Oracle AS node group.

Task 10: Delete Oracle Application Server Node Group

Delete the OracleAS node group:

1 Open the Node Bank and select Oracle AS node group.

2 From the Edit menu, click Delete. The following message appears:

Do you really want to delete the node group?

3 Click Yes.

Task 11: Distribute Actions, Monitors, Commands, and Templates

1 From the Node Bank window, select the nodes or node groups on which you want to install 
OAS SPI. 

2 From the Actions menu select Agents J Install/Update SW & Config. 

3 In the Install/Update OVO Software and Configuration window select the following 
component check boxes:

• Templates

• Actions

• Monitors

• Commands

Using this dialog, deploy updated components on the managed nodes.

4 Select the Force Update check box.

5 Select the Nodes in list option button. Upon completion, the following message appears in 
the message browser for each managed node:

The following configuration information was successfully distributed: 
Actions Commands Monitors Templates.
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Task 12: Launch the Discover OracleAS Application

You must launch the Discover OracleAS application. You are not required to re-enter any of 
the OAS SPI configuration data because all configuration data is saved. To re-deploy the file, 
you can drag and drop multiple nodes, node groups, or single nodes. When you re-deploy the 
file, relevant information is updated, transmitted, and stored on the node.

1 From the OVO console, select the node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Discover OracleAS. (If 
the above does not appear as described, select Map J Reload). The Introduction window 
opens. 

4 Click Next. A second Introduction window opens. Information about the properties 
required for the discovery process to work are given in this window

5 Read this information and click Next. The configuration editor opens.

6 Make the necessary changes using the configuration editor.

7 Click Next to save any changes and exit the editor. The Confirm Operation window opens.

8  Click OK.

If you click Cancel, all the changes made to the configuration will remain in the 
configuration on the management server. To make the changes to the selected managed 
nodes’ configuration, you must select those nodes in the Node Bank window, launch the 
Discovery application, click Next in the configuration editor, and then click OK in the 
Confirm Operation window.

You may see some OAS SPI errors in the message browser. These errors are the result of the 
transition to the updated programs and you can ignore them. OAS SPI templates and 
programs are updated on the Management Server and selected managed nodes. These errors 
are resolved when the upgrade is complete.

When setting the configuration using configuration editor, note the following 
points:
• GRAPH_SERVER property is no longer supported in OAS SPI. Instead, set 

the GRAPH_URL property.
• UDM_DEFINITIONS_FILE property will not be supported in future versions 

of  OAS SPI. Note the locations of the UDM files on your managed nodes and 
delete any occurrence of the UDM_DEFINITIONS_FILE property from your 
configuration.

• Do not configure UDMs individually on your managed nodes, instead 
configure these UDMs on the management server in the 
/opt/OV/wasspi/oas/conf/wasspi_oas_udmDefnintions.xml file (or, 
set the UDM_DEFINITIONS_SOURCE property to use another file).

• After you consolidate the UDMs on the management server, delete the old 
UDM files from the managed nodes and distribute the new UDM file to the 
managed nodes using the Deploy UDM application.

Do not close the Discover application window till the discovery process is complete. The 
discovery process may take several minutes to complete.
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Task 13: Install the New Report Package (Optional)

Remove older versions of OAS SPI report package from your Windows system running OV 
Reporter) and install the new OAS SPI report package. To install the new report package 
follow these steps:

1 On the Windows system running OV Reporter, go to Settings J Control Panel JAdd/Remove 
Programs.

2 Select the OAS SPI report package and click Remove.

3 To install the OAS SPI report package follow the steps given in section Integrating OAS 
SPI with OV Reporter on page 81.

Task 14: Install the New Graph Package (Optional)

• If OVPM is running on a Windows system, remove older versions of  OAS SPI graph 
package and install the new OAS SPI graph package. To install the new graph package 
follow these steps:

a Go to Settings J Control Panel J Add/Remove Programs.

b Select the OAS SPI graph package (HP OpenView SPI for OracleAS - Graphing 
Component Integration) and click Remove.

c To install the OAS SPI graph package follow the steps given in section Integrating 
OAS SPI with HP OpenView Performance Manager on page 84.

• If OVPM is running on a HP-UX system (not the OVO management server) follow these 
steps: 

a Run swlist | grep OASSPI-GRAPHS to verify that the graph package is installed. 

b Run swremove OASSPI-GRAPHS if the graph package is installed.

c To install the OAS SPI graph package follow the steps given in section Integrating 
with HP OpenView Performance Manager on page 67.

• If OVPM is running on a Solaris system (not the OVO management server) follow these 
steps: 

a Run /usr/bin/pkginfo HPOvSpiOasGc to verify that the graph package is 
installed.

b Run /usr/sbin/pkgrm HPOvSpiOasGc if the graph package is installed.

To install the OAS SPI graph package follow the steps given in section Integrating with HP 
OpenView Performance Manager on page 67

If OVPM is installed on the OVO management server, the files are automatically 
updated when you install the SPI software.

If OVPM is installed on the OVO management server, the files are automatically 
updated when you install the SPI software.
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Removing OAS SPI

The complete removal of the OAS SPI installation deletes all OAS SPI components. 

Complete the following tasks: 

• Task 1: Remove OAS SPI Software from the Management Server

• Task 2: Remove OAS SPI Software from the Node Group and Managed Nodes

• Task 3: Delete OAS SPI Templates and Template Groups

• Task 4: Delete OAS SPI Applications

• Task 5: Delete the OAS SPI Message and Node groups

• Task 6: Remove the Report Package (Optional)

• Task 7: Remove the Graph Package (Optional)

Task 1: Remove OAS SPI Software from the Management Server

1 Open a terminal window and log on as root.

2 In the terminal window, enter the following:
/usr/sbin/swremove OASSPI
/usr/sbin/swremove OASSPI-GRAPHS

The swremove command removes the files from the file system only. The OAS SPI templates 
are still in the OVO data repository and must be deleted manually. Before the templates can 
be deleted, they (and the OAS SPI software) must be de-assigned from the managed nodes.

Task 2: Remove OAS SPI Software from the Node Group and Managed Nodes

1 Open the Node Bank and from the Actions menu select Agents J Assign Templates.

2 Select the OracleAS node group and all managed nodes to which Oracle AS templates 
have been assigned.

3 Click Remove nodes/groups.

4 Open the Node Group Bank and select the OracleAS node group.

5 From the Action menu select Install/Update SW & Config and check the following check 
boxes:

• Templates

• Actions

• Monitors

• Commands

6 Select the Nodes in List option button.

7 Select the Force Update option button.

8 Click OK to remove the Templates, Actions, Commands and Monitors from the managed 
node(s). The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors
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Task 3: Delete OAS SPI Templates and Template Groups

Starting from the SPI for OracleAS template group, delete all templates and template groups. 
Once these templates and template groups have been deleted, delete the SPI for OracleAS 
template group. 

1 Open the Message Source Templates window and double-click the SPI for OracleAS 
template group

2 Press SHIFT and click to select all templates and template groups in the SPI for OracleAS 
template group. 

3 Click Delete from All.... The following message appears:

Do you really want to delete the template(s)?

4 Click YES.

5 If additional OAS SPI templates and/or template groups are in the SPI for OracleAS 
template group, repeat steps 2 -4 until you have deleted all OAS SPI templates and 
template groups from the SPI for OracleAS template group. 

6 Go up one level and delete the SPI for OracleAS template group.

Task 4: Delete OAS SPI Applications

Unlike templates, applications can all be removed in a single step. 

1 Open the Application Bank.

2 Right-click the OASSPI application group and click Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

If you have customized templates (copies of OAS SPI default templates) residing in 
other OVO template groups, you should remove them as well.
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Task 5: Delete the OAS SPI Message and Node groups

1 From the Window menu select Message Group Bank.

2 In the Message Group Bank window right-click the OASSPI group and select Delete.

3 Repeat for the OracleAS group.

4 From the Window menu select Node Group Bank.

5 In the Node Group Bank window right-click each OASSPI and OracleAS group and select 
Delete.

Task 6: Remove the Report Package (Optional)

If you installed the OAS SPI report package (on your Windows system running Reporter), 
remove it:

1 On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

2 Select the OAS SPI report package and click Remove.

Task 7: Remove the Graph Package (Optional)

If you installed the OAS SPI graph packages (on the system running OVPM), remove them.

On a Windows system running OVPM, do the following:

1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Select the OAS SPI graph package (HP OpenView SPI for Oracle Application Server 
- Graphic Component Integration) and click Remove.

On an HP-UX system running OVPM that is not the OVO management server, do the 
following (if OVPM is installed on the OVO management server, the files are removed in Task 
1: Remove OAS SPI Software from the Management Server on page 30):

1 Verify that the graph package is installed. Type 
swlist | grep OASSPI-GRAPHS

2 Type swremove OASSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the following 
(if OVPM is installed on the OVO management server, the files are removed in Task 1: 
Remove OAS SPI Software from the Management Server on page 30):

1 Verify that the graph package is installed. Type 
/usr/bin/pkginfo HPOvSpiOasGc

2 Type /usr/sbin/pkgrm HPOvSpiOasGc
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3 Configuring the OAS SPI 
This chapter covers configuring the Smart Plug-in for Oracle Application Server (OAS SPI) for 
use with OpenView Operations (OVO). To successfully configure OAS SPI, you must complete 
all configuration prerequisites, complete OAS SPI configuration (for managed nodes and the 
management server), and complete additional configuration based on your environment.

Configuration Prerequisites

Complete the following tasks before configuring OAS SPI:

• Task 1: Configure the Management Server to Launch your Web Browser

• Task 2: Assign Operator Responsibilities for opc_adm

• Task 3: Assign Templates

• Task 4: Distribute Templates

• Task 5: Update the remactconf.xml File (OVO 8.x Only)

Task 1: Configure the Management Server to Launch your Web Browser 

OAS SPI uses the ovweb utility to start your web browser for running several OAS SPI 
applications including: Start Console (launch the Oracle Application Server Control Console), 
AggreSPY (launch the Oracle servlet that reports performance metrics), Repository (launch 
the Oracle Enterprise Manager Database Control used to manage the Oracle AS Metadata 
Repository database), and View Graphs (display graphed metrics, which requires HP 
OpenView Performance Manager). If you do not want to use these applications, skip this task.

1 Enter the browser invocation command in the ovweb.conf file. If no browser invocation 
command is included in the ovweb.conf file, ovweb tries to start Netscape Navigator 
(which must be version 6.0 or higher). 

The browser invocation command must contain a %s to allow OAS SPI to pass a URL to 
the browser. Open the file and insert the command according to the entry syntax and 
example as follows:

 Syntax: Browser: <browser command> %s
 Example: Browser: /opt/netscape/netscape %s

2 Check the Web browser setting. To display the OAS SPI graphs, ensure that your browser 
is JavaScript enabled. Check the setting within the browser’s Preferences. 

The ovweb.conf file must be located in the directory specified by the 
environment variable $OV_CONF (used by OVO). To find the OVO directory 
structure on your management server, open the /opt/OV/bin/ov.envvars.sh 
file and look for the $OV_CONF definition.
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3 In Task 4: Run Discover OracleAS on page 42, set the following conditional property:

• If you are using OVPM, set the GRAPH_URL property.

For more information about launching a browser in OpenView Operations, consult the man 
pages for ovweb, ovweb.conf, and ov.envvars. To access instructions for enabling graph 
displays, at a command prompt enter: man ovweb

Task 2: Assign Operator Responsibilities for opc_adm

1 Log on to OVO as the administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and choose Modify.

3 In the Modify User:opc_adm user window, click Responsibilities. 

4 For OASSPI and OracleAS Message Groups, ensure that all boxes are checked.

5 Assign the OASSPI Node or Message Groups to any other appropriate operators.

6 Click Close.

Task 3: Assign Templates

Assign the OASSPI-Discovery and OASSPI-Messages templates to the management server:

1 Open the Node Bank window and select the management server.
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2 From the Actions menu, select Agents J Assign Templates. The Define Configuration 
window opens.

3 Click Add. The Add Configuration window opens. 
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4 Click Open Template Window. The Message Source Templates window opens. 

5 From the Message Source Templates window, in the Template Groups pane, select the SPI 
for OracleAS template group.

6 From the Message Source Templates window, in the right pane, select the 
OASSPI-Discovery and OASSPI-Messages templates.

7 From the Add Configuration window, click Get Template Selections. The OASSPI-Discovery 
and OASSPI-Messages templates appear in the right pane.

8 From the Add Configuration window, click OK.

Task 4: Distribute Templates

Distribute the OASSPI-Discovery and OASSPI-Messages templates to the management 
server: 

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents J Install/Update SW & Config. 

3 In the Target Nodes section, select Nodes in List Requiring Update.
36 Chapter 3



4  In the Install/Update Software and Configuration window check the Templates check box.

5 Select Force Update.

6 Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates

The OASSPI-Discovery and OASSPI-Messages templates are distributed to the management 
server. 

Task 5: Update the remactconf.xml File (OVO 8.x Only)

If you are running DCE-based agents on your managed node(s), the discovery process must be 
allowed to run automatic actions on the management server. Do the following:

1 Merge (if you have updated this file) or replace the 
/etc/opt/OV/share/conf/OpC/mgmt_sv/remactconf.xml with the /opt/OV/
wasspi/oas/OV/remactconf.xml file.

2 Restart the OVO management server: opcsv -start (you must restart the management 
server if you modify the remactconf.xml file)

If the remactconf.xml file is not updated, the discovery process fails.
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OAS SPI Configuration (Managed Nodes)

To configure OAS SPI, complete the following task (for each managed node):

• Task 1: Verify the Application Server Status

Task 1: Verify the Application Server Status

Verify that your application servers are running by checking a server’s status from the Oracle 
Application Server Control Console.
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OAS SPI Configuration (from the Management Server)

To configure OAS SPI, complete the following tasks (from the management server):

• Task 1: Assign the OASSPI-Messages Template

• Task 2: Distribute Templates, Actions, Monitors, Commands

• Task 3: Add Nodes to the OracleAS Node Group

• Task 4: Run Discover OracleAS

• Task 5: Verify the Discovery Process

• Task 6: Distribute OAS SPI Templates

• Task 7: Completing Configuration

• Task 8: Verify OAS SPI Configuration

Task 1: Assign the OASSPI-Messages Template

Assign the OASSPI-Messages template to the managed nodes:

1 Open the Node Bank window and select the managed nodes.

2 From the Actions menu, select Agents J Assign Templates. The Define Configuration 
window opens.
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3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 Select the SPI for OracleAS template group.

6 In the right pane, select the OASSPI-Messages template.
40 Chapter 3



7 In the Add Configuration window, click Get Template Selections. The OASSPI-Messages 
template appears in the right pane.

8 Click OK.

Task 2: Distribute Templates, Actions, Monitors, Commands

1 Select the node(s) on which to install the OAS SPI.

2 From the Node Bank’s Actions menu select Agents J Install/Update SW & Config. 

3  In the Install/Update OVO Software and Configuration window select the following 
component check boxes:

• Templates

• Actions

• Monitors

• Commands
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Using this dialog, deploy program components to the managed node(s). 

4 Select the Force Update check box.

5 Select the Nodes in list option button. Click OK. 
Upon completion, the following message appears in the Message Browser for each 
managed node:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors

The OAS SPI is now installed on the selected managed node(s). 

Task 3: Add Nodes to the OracleAS Node Group

OAS SPI automatically creates a single node group (OracleAS) with appropriate template 
groups already assigned. Place any nodes running Oracle OC4J/OHS servers in this node 
group.

1 From the OVO console, open both the Node Group Bank and the Node Bank to display 
(side-by-side) the OracleAS node group and the managed nodes.

2 Drag and drop managed nodes running Oracle OC4J/OHS servers into the OracleAS node 
group. 

Task 4: Run Discover OracleAS

1 At the OVO console, select the OracleAS node group in the Node Group Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin and double-click Discover 
OracleAS.
(If the above does not appear as described, select Map J Reload.)

4 The Introduction window opens. This window contains brief information about the 
Discover OracleAS application.
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Click Next to start the Discovery application.

5 The Confirm Operation window opens. Verify the nodes on which the operation is to be 
performed. Click OK.

Wait for the discover process to complete before going to the next task. The discover 
process may take several minutes to complete. 

Task 5: Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification takes several 
minutes to complete.

1 Verify that the following messages appear in the Discover OracleAS application window 
(the Discover OracleAS application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the Discover OracleAS application does not complete successfully, the following message 
appears in the application window:

Failed to run discovery on node <node>

Refer to Troubleshooting the Discover Process on page 48 for information on how to 
troubleshoot the discovery process.

2 Verify that the following message appears in the message browser for each managed node:

WASSPI-602 - Updating the OASSPI configuration data with discovered 
information

Depending on the number of managed nodes in your environment, it may take several 
minutes for these messages to display for all managed nodes.

3 If Service Navigator is already running, select File J Reload Configurations. In the Services 
tree, open the Application node and look for the Oracle service. 

4 Run the Configure OASSPI application to verify the properties set by the discovery 
process. Refer to Configure OASSPI on page 190 for more information about the 
configuration editor.

Task 6: Distribute OAS SPI Templates

Distribute templates to the managed nodes: 

1 Open the Node Group Bank window and select the OracleAS node group.

2 From the Actions menu, select Agents J Install/Update SW & Config. 

3 In the Target Nodes section select the Nodes in List Requiring Update option button.

4  In the Install/Update Software and Configuration window check the Templates check box.

5 Select Force Update.

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Discover OracleAS application, click Next from the 
configuration editor, and then click OK.
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6 Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed: 
Templates

The OAS-SPI templates are now distributed to the OracleAS node group. OAS-SPI monitors 
can now begin running according to their specific collection interval.

Task 7: Completing Configuration 

Before configuration is complete, the configuration information on the management server 
and managed nodes must be updated. You can either:

• Run the Configure OASSPI application (which updates the configuration information on 
the management server and managed nodes). Refer to Configure OASSPI on page 190 for 
more information. This method is recommended.

Or

• Wait at least 10 minutes for the automatic configuration template to run.

Task 8: Verify OAS SPI Configuration

Run the Verify application to verify that OAS SPI is properly installed and configured (refer to 
Verify on page 201 for more information about this application).

1  At the OVO console, select the OracleAS node group in the Node Group Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin and double-click Verify. 

Additional OAS SPI Configuration

Based on your Oracle Application Server configuration and application needs, you must finish 
OAS SPI configuration by setting additional configuration properties and/or installing and 
configuring additional components. Setting additional properties and configuring additional 
components depends on your environment.

If you use HP OpenView Reporter, see Chapter 5, Integrating OAS SPI with HP OpenView 
Reporting and Graphing Products, for information on integrating OAS-SPI with Reporter. 
Use Reporter to generate Oracle Application Server reports that show more consolidated 
information.
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Conditional Properties

Based on your Oracle Application Server configuration and application needs, you may need 
to set one or more conditional properties. If you meet a condition, set the properties listed to 
the right of the condition (these properties are not automatically discovered by the discovery 
process). For more information about the properties, refer to Configuration Properties on 
page 178.

Setting Conditional Properties

1  At the OVO console, select the node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Configure OASSPI.
(If the above does not appear as described, select Map J Reload.)

4 The Introduction window opens. This window contains brief information about the 
Discover OracleAS application.

Click Next.

5 From the configuration editor, set the properties. Refer to Appendix B, The Configuration 
for more information about using the configuration editor.

6 Click Next to save any changes and exit the editor.

7 The Confirm Operation window opens. Click OK.

Table 1 Conditional Properties

Condition Property to Set

Oracle OC4J/OHS servers on a system share the same name. The discovery 
process automatically sets the ALIAS property, but you may want to edit 
this value as this is the name used in messages, reports, and graphs.

ALIAS

Start or stop an Oracle Application Server using the Start/Stop OracleAS 
application from the OVO console.

START_CMD, 
STOP_CMD, 
and 
USER

Use the View Graphs application from the OVO console (Performance 
Manager must be installed).

GRAPH_URL

If you click Cancel and made changes to the configuration, those changes remain in 
the configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, start the Configure OASSPI application, click Next from the configuration 
editor, and then click OK.
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Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x 
Only)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node 
(OVO 8.x only), do the following:

1 Switch the HTTPS agent to a non-root user. For more information, refer to the HP 
OpenView Operations HTTPS Agent Concepts and Configuration Guide. This document is 
available at http://ovweb.external.hp.com/lpe/doc_serv/ under the product 
Operations for UNIX, version 8.x.

2 Add the OVO agent user account to the local Oracle Application Server user group on the 
managed node. This allows the OVO agent user access to the files in the Oracle 
Application Server installation directories. Use the system administration tool or modify 
the /etc/group file to add the user.

3 On the managed node, set the OV_SUDO variable. As root or with OVO agent user 
privileges, do the following:

a Stop all OVO agents. Run the following command:

opcagt -kill

b Set the OV_SUDO variable. Run the following command:

ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

where <sudo_program> is the location (including the absolute pathname) where sudo 
is installed (for example, /usr/local/bin/sudo).

c Start the OVO agents. Run the following command:

opcagt -start

d Verify OV_SUDO is set. Run the following command:

ovdeploy -cmd set | grep SUDO

The following displayed:

OV_SUDO=<sudo_program>

4 Configure the managed node. These steps MUST be completed to successfully run the SPI 
in a non-root HTTPS agent environment. 

a From the OVO management server, deploy actions, commands, and monitors to the 
managed node.

b Select the node in the Node Bank window. 

c From the Application Bank window, select OASSPI J OASSPI Admin J Init Non-Root.

5 Edit the /etc/sudoers file using the visudo editor (installed with sudo):

a On the managed node, log in as root.

b Open the /<SPI_Config_DIR>/wasspi_oas_sudoers file

where <SPI_Config_DIR> is the location of the SPI’s configuration files on a managed 
node. Refer to Managed Node File Locations on page 161 for more information.

You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo 
is free software available from http://www.sudo.ws. The OS-dependent software packages 
are located at the bottom of the download page (http://www.sudo.ws/sudo/download.html). 
Refer to the release notes for more installation information.
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6 In a separate window, run the visudo command (for example, type: 
/usr/local/sbin/visudo).

c From the wasspi_oas_sudoers file, copy and append the following lines to the 
sudoers file:

Cmnd_Alias OASSPI_ADMN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_admin *
Cmnd_Alias OASSPI_COLL = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_ca *
Cmnd_Alias OASSPI_DISC = /opt/OV/nonOV/perl/a/bin/perl \
wasspi_oas_discovery.pl
Cmnd_Alias OASSPI_LFEN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi_oas_le *
Cmnd_Alias OASSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -S \
shs_collector.pl *

Cmnd_Alias OASSPI_ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_admin *
Cmnd_Alias OASSPI_COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_ca *
Cmnd_Alias OASSPI_DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/OV/bin/instrumentation/wasspi_oas_discovery.pl
Cmnd_Alias OASSPI_LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_oas_le *
Cmnd_Alias OASSPI_SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs_collector.pl *
<OV_Agent_username> <nodename> = NOPASSWD: OASSPI_ADMN, \
OASSPI_COLL, OASSPI_DISC, OASSPI_LFEN, OASSPI_SHSC, \
OASSPI_ADMNP, OASSPI_COLLP, OASSPI_DISCP, OASSPI_LFENP, \
OASSPI_SHSCP

where <OV_Agent_username> is the OVO agent user account and 
<nodename> is the name of the managed node.

d Save the file and exit the visudo editor. Type :wq 

Steps 3 and 4 must be performed every time the agent user is switched.
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4 Using and Customizing OAS SPI
As you become familiar with the Smart Plug-in for Oracle Application Server (OAS SPI), you 
can determine which templates are most useful to you and which you might want to change. 
This chapter assists you by providing more detail on the templates and how to make those 
changes. 

The following topics are covered: 

• Basic Template Customizations

• Advanced Template Customizations

• Re-install the OAS SPI Templates

• Use Templates/Applications to View Annotation Reports and Graphs

• Check OAS SPI Nodes for License Count

Basic Template Customizations

After you begin using the OAS SPI, you may decide that specific OAS SPI templates need 
some modification. Basic customizations, such as changing a threshold (by modifying a 
metrics template) or modifying alarm generation, are covered in this section.

Make copies of the default templates so that they remain intact. Otherwise, your 
customizations are overwritten when you upgrade to the next version. 
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Modifying Metrics Templates

Many metric attributes can be modified for all monitored instances of Oracle OC4J/OHS 
servers by following these steps: 

1 Open the Message Source Templates window.

2 Open the SPI for Oracle AS template group.

3 Open the OASSPI-Metrics template group.

4 Double-click the desired metric which opens the Message and Suppress Conditions 
window.

5 Double-click the desired condition to modify (there may be more than one). The Condition 
window opens. 

The following attributes can be modified:

• Threshold. Enter a value for the metric data that, when exceeded, would signify a 
problem either about to occur or already occurring. 

• Duration. The length of time that the established threshold can be exceeded by the 
incoming data values for a metric before an alarm is generated.

• Severity. The level assigned by the OVO administrator to a message, based on its 
importance in a given operator’s environment. Click Severity to select the desired 
severity setting.

• Message Text. Structured, readable piece of information about the status of a 
managed object, an event related to a managed object, or a problem with a managed 
object. Be careful not to modify any of the parameters—surrounded by <> brackets, 
beginning with $—in a message.
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• Actions. Response to a message that is assigned by a message source template or 
condition. This response can be automatic or operator-initiated. This section provides 
the ability to generate Performance Manager graphs or reports, or to add custom 
programs. 

Automatic action. Action triggered by an incoming event or message. No operator 
intervention is involved. The automatic action delivered with the OAS SPI generates 
a snapshot report that shows the data values at the time the action was triggered 
from an exceeded threshold. You can view the report in the message Annotations.

Operator-initiated action. Action used to take corrective or preventive actions in 
response to a given message. Unlike automatic actions, these actions are triggered 
only when an operator clicks a button. The operator-initiated action delivered with the 
OAS SPI allows you to view a graph of the metric whose exceeded threshold generated 
the message along with other related metric values (click Perform Action within a 
message’s details window).

The following illustration of the Condition window shows a threshold setting of 95 for 
metric OASSPI-0005. This metric monitors the percentage of heap space used in the 
JVM. A value of more than 95 (but less than 98) for 20 minutes would generate an 
alarm (a message of the severity major).

6 Click OK.

7 Re-distribute the modified template as described in Task 6: Distribute OAS SPI 
Templates on page 53.

Modifying Alarm Generation

An alarm can be generated once or multiple times, depending on its Message Generation 
setting in the Modify Threshold Monitor window. 

To change the Message Generation, do the following:

1 Open the Message Source Templates window. 

2 Open the SPI for Oracle AS template group.

3 Open the OASSPI-Metrics template group.

4 Select the template.
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5 Click Modify. The Modify Threshold Monitor window opens. 

6 Modify the Message Generation:

• with Reset: Alarms are generated once when the threshold value is exceeded. At the 
same time a reset threshold value is activated. Only when the reset threshold value is 
exceeded, does the original threshold value become active again. Then when the 
threshold value is again exceeded, another alarm is generated and the process starts 
all over again.

• Without Reset. Alarms are generated once when the monitoring threshold value is 
exceeded. Alarms reset automatically when metric values are no longer in violation of 
the thresholds and are generated again when the threshold is exceeded.

• Continuously. Messages are sent/alerts generated each time the metric values are 
collected and the threshold is exceeded. 

7 Click OK.

8 Re-distribute the modified templates as described in Task 6: Distribute OAS SPI 
Templates on page 53.

Advanced Template Customizations

The template changes suggested here range from making copies of default template groups in 
order to customize a few settings, to deleting whole groups of metrics within a template’s 
command line. This section is considered advanced because all changes described here, 
whether simple or complex, require some advanced knowledge of the OAS SPI metrics.

Choosing Metrics To Customize

Determine which metrics you want to customize and what templates within the group you 
want to use. Then, do the following:

1 Open the Message Source Template window.

2 Select the group you want to use and click Copy....
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3 Rename and save the group.

4 Within the renamed template group, copy each original template and rename it. 

5 Delete the originals within the renamed template group.

6 Customize the renamed templates within the group as necessary. 

Creating a new template group allows you to keep custom templates separate from the 
original default templates, which you copy and place within the new group. 

Using the OAS SPI Collector/Analyzer Command with Parameters

The wasspi_oas_ca command is used in every collector template, named according to its 
collection interval. You can view the default command line parameters within each collector 
template in the Command box in the Modify Scheduled Action window. 

Using the Collector Command Parameters

OAS SPI data collections are started with the wasspi_oas_ca command, to which you can 
add other parameters, as identified in the following table.

Parameter Function Syntax with Example

-e (exclude) Allows you to 
exclude specific servers. This 
option may not be used with 
the -i option.

-e <server_name>
Example: -e server2,server4

-i (include) Allows you to list 
specific servers to monitor. 
This option may not be used 
with the -e option.

-i <server_name>
Example: -i server1,server3

-m (metric) Specifies the metric 
numbers or number ranges 
on which to collect data.

-m <metric_number|metric_number_range>
Example: -m 1,3-5,9-11,15

-matchver (match version) Specifies the 
specific Oracle OC4J/OHS 
server version to monitor. 
This option may not be used 
with the -minver nor 
-maxver options. If no 
matching versions are found, 
the command does not 
execute.

-matchver <version_number>
Example: -matchver 10.1.2

-maxver (maximum version) Specifies 
the highest Oracle OC4J/
OHS server version to 
monitor. Use with -minver to 
specify a range of versions. If 
no versions are found, the 
command does not execute. 

-maxver <version_number>
Example: -maxver 10.1.2
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Syntax Examples

• To collect specific data on all configured servers:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0

• To collect data from specific servers only:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0 -i server1,server2

• To not collect data from specific servers:

wasspi_oas_ca -m 1,2,10,11 -minver 10.0 -e server1,server2

-minver (minimum version) Specifies 
the lowest Oracle OC4J/OHS 
server version to monitor. 
Use with -maxver to specify 
a range of versions. If no 
versions are found, the 
command does not execute.

-minver <version_number>
Example: -minver 10.1.2

-r (report) Generate an ASCII 
report for the specified 
metric(s).

-r

-t (tag) Create a new template 
group by adding a prefix to 
an existing collector template 
and specifying the metric 
number(s). 

-t <prefix>-
Example: wasspi_oas_ca -m 220-223 -t 
DEV-

-x Allows you to specify a 
property/value as follows:

-x <property>=<property_value>

alarm: when off, overrides 
any alarming condition as set 
up in the metric monitor 
template.

-x alarm=off

prefix: Default: JMXUDM_. 
Specify the prefix of the 
metric ID.

-x prefix=SALES_

print: when on, prints the 
metric name, instance name, 
and metric value to STDOUT 
in addition to any configured 
alarming or logging.

-x print=on

log: when off, prevents 
graphing or reporting 
functions.

-x log=off

Parameter Function Syntax with Example
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Changing the Collection Interval for all Metrics

To change the collection interval for all scheduled metrics, change the Polling Interval in the 
appropriate collector template. For example, to change the collection of default metrics from 5 
minutes to 10 minutes for the OASSPI-10-OHS-05min collector template, follow these steps:

1 Select the Message Source Templates window.

2 Select the template group SPI for Oracle AS and open OASSPI-Schedule.

3 Select the collector template OASSPI-OHS-05min.

4 Click Modify.... and change the Scheduled Action Name to OASSPI-OHS-10min.

5 Change the polling interval from 5 minutes to 10 minutes. For example, 0, 10, 20...

6 Distribute the new templates (described in Task 6: Distribute OAS SPI Templates on 
page 53). 

Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template 
and rename with a name reflecting the new interval, deleting all but the metrics you are 
changing. Set the new interval. Edit the original template to remove the changing metrics. 
For example, to change the collection interval to 10 minutes for metrics 10 and 11, you would 
follow these steps:

1 Open the Message Source Templates window.

2 Select the template group SPI for Oracle AS and open OASSPI-Schedule.

3 Select the schedule template OASSPI-OHS-05min.

4 Click Copy... and change the name of the schedule template to OASSPI-OHS-10min.

5 In the Command box, delete all metrics after -m except 10 and 11.

6 Change the polling interval to 10 minutes.

7 Click OK.

8 Select the OASSPI-OHS-05min template.

9 Delete 10, 11 from the Command box.

10 Re-distribute the modified templates as described in Task 6: Distribute OAS SPI 
Templates on page 53.

Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you may want to set the threshold to 90 for 
SERVER_1 for metric 0220 and leave the threshold at 100 for all other servers. To do so, copy 
the existing condition and modify it to serve as the exception. Follow these steps:

1 Double-click to open the metric for customization (for example, OASSPI-0220). 

The Message and Suppress Conditions window is displayed. 
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2 Select the desired condition and click Copy... to make a copy of the condition. 

3 Name the condition OASSPI-0220.2. 

4 In the Object Pattern field, enter the following details:

<ServerName>:<ServerPort>:<NodeName>:<*>:<*>:<*>

For Example: If you want to set threshold for the application server SERVER1, enter the 
following:

SERVER1:<*>:<*>:<*>:<*>:<*>

5 Click the Test Pattern Matching… to test the pattern and verify pattern matching (you must 
set up a match file first).

6 Change the value in the Threshold field from 100 to 90.

Creating Custom, Tagged Templates 

Another advanced customization option is to use the tag option (-t on the command line), 
which allows the collector/analyzer to recognize customized templates that have a tag 
attached to the name. This option provides you with the flexibility of using more than a single 
set of templates to define conditions pertaining to specific installations of Oracle Application 
Server.

When multiple nodes are managed by a number of groups, this option allows you to create 
specially tagged templates that are obviously separate from your original setup. In such a 
case, you would make copies of the templates, rename them with the tag and re-work the 
collector template to pick up the tagged names, then assign them to the various groups. 

For example, you might create a group of templates and change each template name to 
include CLIENT01 in it. A metric monitor template might be named 
CLIENT01-OASSPI_0001 (retaining the metric number, which must be used). The collector 
template name would be named FIRST_CLIENT-OHS-05min. You could then set up another 
group for SECOND_CLIENT and change all those templates to include the CLIENT02 in the 
name.

To create the new template group:

1 Copy the original template group. In the Message Source Templates window select the 
group and click Copy....

2 Name the new group according to how you plan to identify the new schedule and collector 
templates. For example, if you are including CLIENT01 in the template names, include it 
within the new template group name.

3 In the Message Source Template window expand the new template group to show all 
templates and select each template you plan to use, click Copy..., and rename it according 
to your naming scheme. 

• The names you give the new metric monitor templates in the group would contain the 
new name followed by the original metric number. For example, a copy of 
OASSPI-0001 could be called CLIENT01-OASSPI_0001.

• The name you give the new collector monitor template would also contain the 
identifying name. You would also modify the scheduled collection for the new group by 
inserting the -t property on the command line. For example: 

wasspi_oas_ca -m 1 -t CLIENT01-

4 Delete all original templates from the new group.
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Template Variables

The following variables are used by the OAS SPI templates. If you are creating your own 
templates, you may use these variables.

Name Description

instancename The instance for which the metric is being reported for 
multi-instance metrics.
Example: /oc4j/Petstore/EJBs/shoppingcartEjb.jar/
TheCart/ejbActivate

node The node on which the OC4J/OHS server is running.
Example: moo1.hp.com

servername The OC4J/OHS server name. Corresponds to the NAME 
configuration property.
Example: my server

service_key The service ID used to light up the nodes in the service map.
Using and Customizing OAS SPI 57



Re-install the OAS SPI Templates

When OAS SPI templates are installed in OVO, the commands shown below automatically 
uploads them when swinstall is run. Any customized template settings you may have done for 
the previous installation are overwritten. 

To restore the default SPI for Oracle AS template group you had originally installed, delete all 
current templates first, then run the command:

/opt/OV/bin/OpC/opccfgupld -silent1 -replace 
-subentity /var/opt/OV/share/tmp/OpC_appl/wasspi/oas/oas_set

1 Alternatively, you can use the -verbose option instead of the -silent option.

Use Templates/Applications to View Annotation Reports and 
Graphs

Some templates have actions defined with threshold violations or error conditions that 
automatically cause reports to appear in the message Annotations. These reports are 
snapshots of data values collected form the server around the time that the alarm occurred.

Other templates have operator actions associated with them that allow you to generate a 
graph. 

You can access the data as follows:

• To view the Message Details, double-click a message in the OVO message browser, or just 
select the message and click Annotations. You can easily access Annotations by clicking  
Annotations. Reports are available there, showing data values on a single server. 

• To view reports, open both the Node Bank and Application Bank windows. Continue to 
open application windows OASSPI J OASSPI Admin J Reports. Select a node and drag it 
onto the OASSPI metric report you need. These reports show all server data on a node. 

• To view graphs, open both the Node Bank and Application Bank windows. Continue to 
open application windows OASSPI J OASSPI Admin. Drag a node onto the View Graphs 
application to launch your Web browser, which opens the graphing feature available in HP 
OpenView Performance Manager (which must be purchased separately).

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports are generated as soon as an 
alarm is triggered in OVO. Automatic Action reports show the state of the system moments 
after the alarm occurred. 

The reports discussed in this section should not be confused with those generated by 
OpenView Reporter, which show more consolidated, historical data generated as web pages in 
management-ready presentation format.
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Viewing an Automatic Action Report

When an Automatic Action Report is executed from OVO, the server is queried for additional 
data. If your message browser is set to display the SUIAONE column, there is an S under the 
A column (see illustration), which indicates that a generated report is available in the 
Annotations area of the Message Details.

To view the report, click Annotations... in the Message Browser. Column descriptions provide 
further clarification.

Application Bank Reports

You can use Application Bank Reports to manually generate a report similar to an Automatic 
Action report.

Application Bank reports run for all Oracle OC4J/OHS server instances configured on the 
managed node, in contrast to Automatic Action Reports which are generated for a single 
Oracle OC4J/OHS server instance. The reports generated from the Application Bank reflect 
the current state of Oracle OC4J/OHS server on the managed node.  
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To generate a report in OVO, simply drag the managed node from the Node Bank window to 
the desired report in the Application Bank window.

The report below appears in the Annotations area of the message details.
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Sample Report

The following example shows the format of a OAS SPI report. This report is automatically 
generated (automatic action report) for metric C280.  
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Check OAS SPI Nodes for License Count

You can use an OVO reporting utility to check the number of templates you have installed on 
your managed nodes. In reviewing the number of templates per managed node, you can see if 
you have consistently installed templates across your managed systems. In addition, by 
running this report, you can also ensure that the number of licenses you have purchased is in 
compliance with the report results.

To run the report:

1 At the OVO console select the node or node group that you want to check.

2 From the Actions menu select Utilities J Reports....

3 In the Reports window among the reports listed select OASSPI License Check.

4 Select an output destination and click OK.
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5 Integrating OAS SPI with HP OpenView 
Reporting and Graphing Products
The Smart Plug-in for Oracle Application Server (OAS SPI) can be integrated with the 
following HP OpenView reporting and graphing products (these products must be purchased 
separately): 

• HP OpenView Reporter (Reporter)

• HP OpenView Performance Agent (OVPA)

• HP OpenView Performance Manager (OVPM)

HP OpenView Reporter. Reporter produces management-ready, web page reports, showing 
historical and trending information. This is not the version of Reporter that is included with 
HP OpenView Operations. 

Working in conjunction with Reporter, the OAS SPI produces a variety of reports showing 
consolidated information on the Oracle Application Server.

Refer to Integrating with OV Reporter on page 65 for more information on how to integrate 
OAS SPI with Reporter. After integrating OAS SPI with Reporter, every night, Reporter 
generates reports that show the performance and availability of an Oracle Application Server 
on configured managed nodes.

HP OpenView Performance Agent. OVPA collects, summarizes, time stamps, and detects 
alarm conditions on current and historical resource data across your system. It provides 
performance, resource, and end-to-end transaction response time measurements, and 
supports network and database measurement information. Refer to the HP OpenView 
Performance Agent for UNIX User’s Manual for more information about OVPA. 

HP OpenView Performance Manager. OVPM provides graphing capability of OAS SPI 
metrics.

Refer to Integrating with HP OpenView Performance Manager on page 67 for more 
information on how to integrate OAS SPI with OVPM. After integrating OAS SPI with 
OVPM, graphs are available the following day. 

Integrating with CODA

The OAS SPI can detect if you are using OpenView Performance Agent (OVPA or 
MeasureWare Agent). If you are, the OAS SPI installation automatically uses it. 

If you want to use the HP OpenView Operations subagent (CODA) included with OVO 7.0 or 
greater, you must configure the managed nodes to do so. Note that there are no advantages to 
using CODA instead of OVPA. 
  63



To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda.opt file in the following directory:

If the directory dsi2ddf does not exist, create it.

2 Save the empty file.

Operating System File Location

HP-UX, Linux, Solaris /var/opt/OV/conf/dsi2ddf/ 

AIX /var/lpp/OV/conf/dsi2ddf/

Windows \usr\ov\conf\dsi2ddf\ 
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Integrating with OV Reporter

The OAS SPI must be configured (see Chapter 3, Configuring the OAS SPI) before it can be 
integrated with Reporter.

The OAS SPI report package must be installed on the Windows system running Reporter: 

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the 
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:

\OV_REPORTER\ORACLEAS_SPI_04.20.000\OASSPI-Reporter-04.20.000.msi

2 Follow the instructions as they appear.

3 Check the Reporter status pane (see the illustration that follows) to note changes to the 
Reporter configuration. 

The status pane (at the bottom of the Reporter window) shows you information on the 
programs running and any errors occurring. You can check the status pane to see that 
Reporter has been updated with the OAS SPI reports. 

You can find instructions in the Reporter Help for assigning OAS SPI reports to the 
targeted nodes. To access Help, select Reports or Discovered Systems in the left panel of 
the Reporter main window and right-click. Select Report Help or Discovered Systems 
Help from the submenu that appears. See the topic “To assign a report definition to a 
Discovered Systems Group.”

4 Add group and single system reports by assigning reports as desired. (See the Reporter 
Help and the online Concepts Guide for complete information.)

OAS SPI Reports

The reports available through the integration of HP OpenView Reporter and OAS SPI show 
consolidated data on server performance and availability on Oracle Application Server 
systems. These reports are available the day following your installation of the OAS SPI report 
package on the Reporter Windows system. (See Integrating with OV Reporter on page 65 if 
you have not yet completed the report package installation.)

For Windows 2000 managed nodes, during the installation an error message may appear that 
indicates the installer has detected an older version of the installer on your system. You can 
safely ignore the message and continue.

Group and single system OAS SPI reports require that you identify systems by their full 
name. For example, abc.xyz.com is acceptable while abc is not.
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The tables that follow show all pre-defined reports for groups (one or more managed nodes on 
which an Oracle Application Server is installed) and single systems. 

Table 2 Group Reports

Title Description
OracleAS 
Version Metric

Availability The percentage of up time of all Oracle 
Application Servers by day

9.04, 
10.1.2, 
10.1.3

2

EJB Method Calls Process 
Rate - Top 20

The number of all EJB method calls 
processed per minute for the top 20 OC4J 
servers

9.04, 
10.1.2, 
10.1.3

22

Servlet Active Threads - Top 
20

The number of servlet active threads for 
the top 20 OC4J servers

9.04, 
10.1.2, 
10.1.3

42

Servlet Average Execution 
Time - Top 20

The servlet average execution time for 
the top 20 OC4J servers

9.04, 
10.1.2, 
10.1.3

240

Table 3 Single System Reports

Title Description
OracleAS 
Version Metric

HTTP Server and OC4J 
Availability Details

The percentage of hourly up time per day 
during the reporting period

9.04, 
10.1.2, 
10.1.3

2

HTTP Server and OC4J 
System Resource Utilization

The hourly average of the percentage of 
CPU utilization and the percentage of 
system memory utilization per day 
during the reporting period

9.04, 
10.1.2, 
10.1.3

10, 11

HTTP Server Connections The average number of HTTP server 
connections per day for each application 
server on the selected system

9.04, 
10.1.2, 
10.1.3

100

DB Connection Cache 
Utilization

The hourly average of the percentage of 
database connection cache utilization per 
day during the reporting period

9.04, 
10.1.2, 
10.1.3

260

OC4J WebContext Sessions The average number of WebContext 
sessions per day for each OC4J instance

9.04, 
10.1.2, 
10.1.3

281
66 Chapter 5



Integrating with HP OpenView Performance Manager

To integrate OAS SPI with OVPM, do the following:

1 Install and configure the OAS SPI. Verify that you have completed Task 1: Configure the 
Management Server to Launch your Web Browser on page 41. Also, verify that you have 
set the GRAPH_URL property. Refer to Property Definitions on page 180 for more 
information about the GRAPH_URL property.

2 If you are upgrading the OAS SPI graph package, you must remove the old version before 
installing the new version. For information on removing the OAS SPI graph package see 
Task 14: Install the New Graph Package (Optional) on page 29.

3 Install the graph package.

On a Windows system running OVPM, do the following:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the 
DVD-ROM drive, and in Windows Explorer, double-click:

\OV_PM\ORACLEAS_SPI_04.20.000\WINDOWS\HPOvSpiOasGc-04.20.000.msi

b Follow the instructions as they appear.

On an HP-UX system running OVPM that is not the OVO management server, do the 
following (if OVPM is installed on the OVO management server, the files are already 
swinstalled):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

swinstall -s <mount_point>/OV_PM/ORACLEAS_SPI_04.20.000/HPUX/
HPOvSpiOasGc-04.20.000.sdtape OASSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the 
following (if OVPM is installed on the OVO management server, the files are already 
installed):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/ORACLEAS_SPI_04.20.000/
SOLARIS/HPOvSpiOasGc-04.20.000.sparc all

4 To graph any Oracle Application Server metric, use the data source name 
OASSPI_METRICS

Refer to the OVPM documentation for information on how to view the graphs. Graphs are 
available the day following integration.

Allow sufficient collection intervals to occur before attempting to view graphs (using 
OpenView Performance Manager).

Data Source Description

Metrics collected by the OAS SPI are stored in the data sources named OASSPI_METRICS and 
OASSPI_RPT_METRICS. The values can be viewed for trend analysis.

Class OASSPI_METRICS
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Viewing Graphs that Show Alarm Conditions

For graphing purposes, the OAS SPI organizes metrics according to type. When a message is 
generated for any metric appearing in a table in the section that follows, you can view a chart 
of its and other metric values. 

To view a graph associated with an alarm condition (Operator-initiated action has been 
defined with the OAS SPI monitor template), complete these steps:

1 In the OVO Message Browser double-click the message.

2 In the Message Details window, click Perform Action.

Column Attribute

1 SERVERNAME
2 OBJECTNAME
3 C005_JVMMEMUTILPCT
4 C010_CPUUTILPCT
5 C011_MEMORYUTILPCT
6 C100_HTTPSVRACTCONN
7 C108_HTTPAVGRESPSZRQ
8 C109_HTTPVHAVRSPSZRQ
9 C020_EJBCLACTTHREADS

10 C021_EJBCLAVGEXECTIM
11 C022_EJBCLCALLSPRCRT
12 C030_EJBWRAPACTTHRDS
13 C031_EJBWRPAVEXECTIM
14 C032_EJBWRPCALLPRCRT
15 C042_SRVLTACTTHREADS
16 C047_JSPACTREQUESTS
17 C050_JMSCONNCREATED
18 C260_JDBCCONPOOLUTIL
19 C280_WEBCNTXTAVRQPRC
20 C281_WEBCNTXTACTSESS

Class OASSPI_RPT_METRICS

Column Attribute

1 METRICID
2 VALUE
3 SERVERNAME
4 OBJECTNAME
5 INSTALLATION
6 APPLICATION
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The resulting action displays the metric’s OAS SPI graph, which charts its values along with 
the values of other metrics in the same group. 

Viewing Graphs that Show Past/Current Conditions

You can also generate any of the graphs manually by using the View Graphs application. 

To manually generate a graph:

1 At the OVO console open both the Node Bank and the Application Bank windows.

2 In the Node Bank window, select the node for which you want the graph generated.

3 In the Application Bank window double-click OASSPI and in the next window 
double-click OASSPI Admin.

4 Drag and drop the node onto the View Graphs application.

OAS SPI Metrics Available for Graphs

The tables that follow show the graphs available for mapping collected metric values. If you 
are interested in viewing any one of the metrics included in any of these tables, you can use 
the View Graphs application to launch the graph, which appears in your Web browser.

Title Description
OracleAS 
Version Metric

JVM Memory Utilization JVM heap memory utilization 9.04, 
10.1.2

5

CPU and Memory Utilization Percentage of server CPU time 
utilization and server memory size 
utilization

9.04, 
10.1.2

10, 11

HTTP Server Active 
Connections

Number of active connections to the 
HTTP server

9.04, 
10.1.2

100

HTTP Server Response Data HTTP server average response data size 
processed and HTTP server average 
response data size processed for the 
virtual host

9.04, 
10.1.2

108, 
109

OC4J EJB Threads EJB method client and EJB method 
wrappers active threads count

9.04, 
10.1.2

20, 30

OC4J EJB Execution Time Average execution time of the EJB 
method client and EJB method wrappers

9.04, 
10.1.2

21, 31

OC4J EJB Calls Process Rate EJB method client calls and EJB method 
wrappers calls process rate for the 
interval

9.04, 
10.1.2

22, 32

Servlet Threads Total number of threads servicing all 
servlets

9.04, 
10.1.2

42

JSP Requests Number of active JSP requests 9.04, 
10.1.2

47
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Launching the Web Page Display with an Operator Action that Generate Graphs

Performance Manager graphs can be generated from most OAS SPI alarm messages by 
pressing Perform Action from the message details, Properties, or the Message Browser. The 
operator action launches your Web browser, which displays a graph of the metric that 
generated the message, as well as other related metrics.

Specifying a Date Range

Within the web page display, you can specify a date range of one day, one week, one month, or 
one year. Refer to the online Help for instructions on changing display settings.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by 
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all 
data for all instances are reported in one graph. The data for each SERVERNAME can also be 
displayed in a separate graph.

JMS Metrics Number of JMX connections (local and 
remote) created by the JMS server during 
the interval and number of messages in 
the destination store

9.04, 
10.1.2

50, 51

JDBC Connection Pool Percentage of JDBC connection pool 
utilization

9.04, 
10.1.2

260

OC4J Web Context Requests OC4J web context average request 
processing time and number of active 
sessions

9.04, 
10.1.2

280, 
281

Title Description
OracleAS 
Version Metric
70 Chapter 5



This example also uses the Java interface option of OVPM.

1 Start the Java Interface option of OVPM. The Performance Manager Java Interface 
window opens.

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window, and then the Sources tab at the right of 
the window.

b Click  next to the Datasource text box and select a data source 
(OASSPI_RPT_METRICS).

c Click  next to the Default Selection text box and select the node on which the data 
source resides.
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3 Click the General tab at the right of the window. 

4 From this window,

a Select line from the Type drop-down list. This generates a line graph.

b Enter a Date Range.

c Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection 
window opens. 

6 From the Metric Selection window,

a Next to the OASSPI_RPT_METRICS data source, click + to expand it in the tree.

b Select the VALUE check box.

c Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which 
VALUE is displayed and click Properties. The Metric Properties window opens. 

8 From the Metric Properties window,

a In the Label text box, enter: 

— @@SERVERNAME:@@OBJECTNAME if you are creating one graph with all 
SERVERNAMEs 

— @@OBJECTNAME if you are creating one graph with one SERVERNAME

b In the Marker drop-down list, select any marker other than none.

c In the Missing Data drop-down list, select:

— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click  next to the Filter text box. The Metric Filter window opens.

9 From the Metric Filter window,

a Select METRICID from the first drop-down list.

b Select = from the second drop-down list (if it isn’t already selected).

c Enter a metric number (for example, 11) in the text box.

d Click OK.

10 From the Metric Properties window,

a In the Filter text box, append the following:

— &&SERVERNAME=@&&OBJECTNAME=@@ if you want one graph to display all 
SERVERNAME/OBJECTNAME combinations.
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— &&SERVERNAME=”<server_name>”&&OBJECTNAME=@ if you want one graph to 
display one SERVERNAME and all OBJECTNAMEs associated with the 
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file. 
Refer to step step 13 on page 75 for more information.

b Click OK.

11 Click Save As at the top of the window. The Save As window opens.

12 From the Save As window,

a Enter a family (for example, OASSPI_Graphs) in the Family text box. The family 
name serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name text box to uniquely identify the 
graph.

c Entering text into the Category text box is optional. 

d Click OK. The information is saved in a graph template file named 
VPI_GraphsUser<family>.txt (for example, 
VPI_GraphsUserOASSPI_Graphs.txt).

For more information about this window, refer to the online help.

13 Edit the graph template file. The file is located in the OpenView data directory on the 
system of the OVPM instance on which you are working. The graph file may look similar 
to Figure 1.
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Figure 1

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: to the end of the first section of each graph (in the example above, 
add SUMFROMRAW: after SYSTEMNAME: moo1). This allows OVPM to summarized data 
from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter text box in the Metrics Properties window in step 
step 10 on page 74, edit the FILTER field.

c Save the file. The graph file now contains the following (see Figure 2):

#*********************************************

#* user Defined Graph Templates

#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] moo1

#**********************************************

FAMILY: OASSPI_Graphs

GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR:Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:
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Figure 2  

#*********************************************

#* user Defined Graph Templates
#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] moo1
#**********************************************
FAMILY: OASSPI_Graphs
GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

SUMFROMRAW:

END_GRAPH:
MISSINGDATA: previous
MARKER: rectangle
COLOR:Auto
LABEL: @@SERVERNAME:@@OBJECTNAME
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
METRIC: VALUE
CLASS: OASSPI_RPT_METRICS:OASSPI_RPT_METRICS

SUMFROMRAW:
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14 From the Performance Manager Java Interface window, click the Display tab.

15 In this window,

a In the window below the Sources text box, navigate to the server on which the data 
source resides.

b In the Graphs window, navigate to the family of graphs and select the graph you 
created.

c Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph opens.

16 From the SPI, enable graphing

a From the OVO console, open the Node Bank window and select a node or groups of 
nodes on which you want to enable graphing. 

b Open the Application Bank window.

c In the Application Bank window select OASSPI J OASSPI Admin. 

d Double-click UDM Graph Enable.

If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from 
the graph template file. You must edit the graph template file and re-enter this 
entry.
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6 Basic Troubleshooting and Error Messages
Using the Self-Healing Info Application

Preferred troubleshooting method: Troubleshooting information is enhanced with 
cross-referencing capabilities available through the HP support site:
http://support.openview.hp.com/self_healing.jsp. To access this information and the 
search capabilities available on the site, you must first download and configure the 
Self-Healing Services client software, an added benefit of your HP support contract. A link is 
then automatically set up to the self-healing services web site, where your SPI problem can be 
matched to similar SPI problems/solutions for increased troubleshooting effectiveness. Refer 
to the Self-Healing Services section in the HP OpenView Smart Plug-ins DVD Installation 
Guide for UNIX for information on how to download, configure, and use the software and its 
automatic link to the HP web site support service.

Alternative troubleshooting method: If self-healing services is not installed/configured on 
the node, you can use the Self-Healing Info application. This application also gathers SPI 
troubleshooting data and stores it in a file that you submit to HP support for assistance. Refer 
to Self-Healing Info on page 195 for more information about using this application.

The file created by the Self-Healing Info application may be hidden on some Windows 
managed nodes. If you do not see the file, open Windows Explorer and, from the Tools menu, 
select Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden 
files and folders.
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Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OvInstallDir%>/ is 
/var/opt/OV)

UNIX Managed Nodes

The following log and trace files are found on the managed nodes running on UNIX (typically, 
/<OvAgentDir>/ is /var/opt/OV/ or /var/lpp/OV/):

File Type Log

Filename /<%OvInstallDir%>/WASSPI/oas/log/ 
<managed_node>_disc_server.log

Description Records the updates done by the OASSPI Discovery policy to the 
management server’s configuration for each managed node. Log files are 
overwritten each time the discovery policy is run on the managed node. 
Logging to this file is always enabled.

File Type Log

Filename /<OvAgentDir>/log/javaagent.log

Description OVO discovery agent log file containing the status of the OVO discovery 
agent. By default, logging to this file is enabled at LOG_LEVEL 3. Set 
the LOG_LEVEL variable in <OvAgentDir>/conf/svcDisc/
OvJavaAgent.cfg to 6 or higher (up to 9) to capture troubleshooting 
information (the higher the number, the more information is collected). 
To disable this log, set the LOG_LEVEL to 0. Additional information can 
be configured in this file to define log file size and the number of archived 
files kept. By default, the log file size is 1MB and five archived versions 
are kept.

File Type Log

Directory /<OvAgentDir>/wasspi/oas/log/config.log

Description Records output from the OAS SPI configuration scripts. 

File Type Log

Directory /<OvAgentDir>/wasspi/oas/log/errorlog

Description Records OAS SPI error messages. This log file is monitored by OAS SPI 
policies.
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File Type Trace

Filename /<OvAgentDir>/wasspi/oas/log/wasspi_oas_discovery.trc 
(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. By 
default, tracing to this file is enabled. To disable tracing, in 
<OvAgentDir>/bin/instrumentation/
wasspi_oas_discovery.pl, set the $trace_on variable to 0. To enable 
this trace, set the $trace_on to 1. When instrumentation is deployed, the 
wasspi_oas_discovery.pl file is overwritten (therefore, if you 
disable tracing, it becomes enabled when instrumentation is deployed). 
Five archived versions are kept. A new trace file is created when the 
discovery policy is run.

File Type Trace

Directory /<OvAgentDir>/wasspi/oas/log/trace.log (archived files have a 
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTANT or TRANSIENT mode in the SPIConfig 
file. The default value of the Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use the 
Start Tracing application.

File Type Trace

Directory /<OvAgentDir>/wasspi/oas/log/traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
'PERSISTENT' mode in the SPIConfig file. The default value of the 
Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
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Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows 
(typically, <OvAgentDir> is 
\Program Files\HP OpenView\Installed Packages\{790 ...}\):  

File Type Log

Filename \<OvAgentDir>\log\javaagent.log

Description OVO discovery agent log file containing the status of the OVO 
discovery agent. By default, logging to this file is enabled at LOG_LEVEL 
3. Set the LOG_LEVEL variable in 
<OvInstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher 
(up to 9) to capture troubleshooting information (the higher the 
number, the more information is collected). To disable this log, set the 
LOG_LEVEL to 0. Additional information can be configured in this file 
to define log file size and the number of archived files kept. By default, 
the log file size is 1MB and five archived versions are kept.

File Type Log

Directory \<OvAgentDir> \wasspi\oas\log\config.log

Description Records output from configuration scripts.

File Type Log

Directory \<OvAgentDir> \wasspi\oas\log\errorlog

Description Records OAS SPI error messages. This log file is monitored by OAS 
SPI policies.

File Type Trace

Filename \<OvAgentDir>\wasspi\oas\log\wasspi_oas_discovery.trc 
(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. 
By default, tracing to this file is enabled. To disable tracing, in
\<%OvInstallDir%>\bin\instrumentation\
wasspi_oas_discovery.pl, set the $trace_on variable to 0. To 
enable this trace, set the $trace_on to 1. When instrumentation is 
deployed, the wasspi_oas_discovery.pl file is overwritten 
(therefore, if you disable tracing, it becomes enabled when 
instrumentation is deployed). Five archived versions are kept. A new 
trace file is created when the discovery policy is run.
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File Type Trace

Directory \<OvAgentDir> \wasspi\oas\log\trace.log (archived files have a 
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTANT or TRANSIENT mode in the 
SPIConfig file. The default value of the Collector Mode is 
'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.

File Type Trace

Directory \<OvAgentDir>\wasspi\oas\log\traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
'PERSISTENT' mode in the SPIConfig file. The default value of the 
Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
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Troubleshooting the Discover Process

Problem: The OASSPI-Discovery template does not automatically discover and update the 
OAS SPI configuration.

Solutions:

1 Check for errors in the message browser of the managed nodes not being discovered. 
Follow the instruction text of any error messages displayed.

2 Verify that an Oracle OC4J/OHS server is installed on the managed node. If an OC4J/
OHS server is not installed, install an OC4J/OHS server, and complete the configuration 
tasks listed in Chapter 3, Configuring the OAS SPI.

3 Verify the Oracle Application Server status. The application server must be running. See 
Task 1: Verify the Application Server Status on page 47 for more information.

4 Verify the Java home directory (see Verifying the Java Home Directory on page 85).

5 Verify that the Configure OASSPI application is not running. Only one process can access 
the configuration at a time. If Configure OASSPI is running, other processes that must 
access the configuration (like the discovery process) hang until the configuration becomes 
available.

6 Check if the OVO management server is suppressing duplicate messages: 

a From the OVO console, select Actions Server Configure. The Configure Management 
Server window opens.

b Look for the “Suppress and count duplicate messages” check box. If this box is 
selected, unselect it.

7 Restart the OVO management server:

a Stop all OVO GUIs that are running by selecting File J Exit.

b Stop the OVO management server processes. Enter: 
/opt/OV/bin/ovstop opc ovoacomm

c Delete all OVO temporary files. All pending messages (messages not saved in the 
database) and all pending actions (automatic actions, operator-initiated actions, 
scheduled actions, and command broadcast) are lost. Enter: 
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*

d Restart the OVO management server process. Enter: 
/opt/OV/bin/OpC/opcsv -start
/opt/OV/bin/OpC/opcsv -status

e Restart the OVO GUI. Enter: opc

Problem: The OASSPI-Discovery template is adding inaccurate information to the 
configuration.

Solutions:

1 Verify the Java home directory. Refer to Verifying the Java Home Directory on page 85 for 
more information.

2 Update the configuration and unselect the AUTO_DISCOVER check box in the 
configuration editor to prevent the OASSPI-Discovery template from overwriting the 
configuration information.

Problem: The following error messages display when the Discover OracleAS application is 
run:
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/usr/lib/dld.sl: Can’t find path for shared library: libiconv.sl
/usr/lib/dld.sl: No such file or directory
sh: 25691 Abort (coredump)

Solution:

Install the libiconv.sl file on the OVO management server. Download this file from:
http://hpux.connectisl.com/hppd/hpux/Development/Libraries/

Verifying the Java Home Directory

In order to successfully use the OASSPI-Discovery template, the Java home directory (on both 
a Windows and UNIX managed node) must be configured correctly.

Although the discover template searches for this information, if it cannot find this 
information or the information is not accurate, the discover template does not function 
completely.

On each managed node on which you want to run the discover template, verify one of the 
following (listed in the order of precedence used by the discover template):

• JAVA_HOME is correctly defined in the configuration. To edit/view the configuration, run 
the Configure OASSPI application:

a At the OVO console, select the node(s) in the Node Bank window. 

b Select Application Bank.

c In the Application Bank window select OASSPI J OASSPI Admin J Configure OASSPI. 
(If the items do not appear, select Map J Reload.)

d The Introduction window opens. 

Click Next.

e From the configuration editor, set the JAVA_HOME property. Refer to Using the 
Configuration Editor on page 165 for more information about using the configuration 
editor.

f Click Save to save the changes made to the configuration. Once you save your changes, 
you cannot automatically undo them.

g Click Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Click OK.

h Run the Discover OracleAS application on the managed nodes on which the 
JAVA_HOME property was added or edited. Running the Discover OracleAS 
application updates the service map.

• The JAVA_HOME system variable is correctly defined.

On a Windows manage node, do the following:

i Select Start J Settings J Control Panel.

j Double-click System.

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Discover OracleAS application, click Next from the 
configuration editor, and then click OK.
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k Click the Advanced tab.

l Select Environment Variables ...

m Scroll through the System variables list. Verify the JAVA_HOME value. If 
JAVA_HOME does not exist, it is not defined.

On a UNIX manage node, do the following:

a Type echo $JAVA_HOME

Verify the output. If no output is returned, JAVA_HOME is not defined.

Troubleshooting the Configuration

Problem: The OASSPI-Discovery template overwrites the configuration with inaccurate 
information.

Solution: Update the configuration and unselect the AUTO_DISCOVER check box in the 
configuration editor to prevent the OASSPI-Discovery template from overwriting the 
configuration information.
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Troubleshooting the Applications

• Problem: Configuration variable SERVER<n>_START_CMD missing for server ‘Default 
Server’

Solution: Before you can successfully run the Start OracleAS application, you must set 
the START_CMD and USER properties. Set these properties using the Configure OASSPI 
application. Refer to Configure OASSPI on page 190 for more information about this 
application.

• Problem: Configuration variable SERVER<n>_STOP_CMD missing for server "Default 
Server"

Solution: Before you can successfully run the Stop OracleAS application, you must set 
the STOP_CMD and USER properties. Set these properties using the Configure OASSPI 
application. Refer to Configure OASSPI on page 190 for more information about this 
application.

• Problem: When launched, the Verify application gives improper output.

Solution: Before you launch the Verify tool ensure that you have installed the latest 
version of Self-Healing Service (SHS) component (version 2.20) from the SPI DVD. If you 
upgrade OAS SPI without the SPI DVD then you must upgrade the SHS component also. 
You can download the SHS component from
http://support.openview.hp.com/self_healing_downloads.jsp.

• Problem: When launched, the Self-Healing Info application gives improper output.

Solution: Ensure that you have installed the latest version of Self-Healing Service (SHS) 
component (version 2.20) from the SPI DVD. If you have upgraded OAS SPI without the 
SPI DVD then you must upgrade the SHS component also. You can download the SHS 
component from
http://support.openview.hp.com/self_healing_downloads.jsp.

• Problem: When launching the applications, the applications hang or there is no output.

Solution: The tools will not work if the memory is low. Check the performance of the node 
and the management server. The physical memory available must be more than 500 MB.

• Problem: View Status application shows a wrong status for a server instance or does not 
give any output.

Solution: If a server is up and running but View Status application returns the server 
status as NOT_RUNNING (or does not give any output), then turn ON the monitoring for 
that particular server by using the Start Monitoring application.

• Problem: Datasource not getting created on RHEL 4.0 platform.

Solution: Ensure that you have installed the latest version of DSI2DDF component 
(02.22.000) from the SPI DVD. If you have upgraded OAS SPI without the SPI DVD, then 
you must upgrade the DSI2DDF component also. You can download the latest DSI2DDF 
component from:
ftp://ovrntfs.rose.hp.com/prelim/dsi2ddf/02.22/HPUX11.00/
DSI2DDF_A.02.22.00.sdtape
Basic Troubleshooting and Error Messages 87

http://support.openview.hp.com/self_healing_downloads.jsp
http://support.openview.hp.com/self_healing_downloads.jsp
ftp://ovrntfs.rose.hp.com/prelim/dsi2ddf/02.22/HPUX11.00


Error Messages

This section provides detailed information on error messages resulting from conditions 
detected in the operation of the OAS SPI, not the Oracle Application Server itself. The error 
messages discussed here are all within the OASSPI Message Group.

In the figure below, the last two messages are a result of errors in the operation of OAS SPI. 
These errors are identified as belonging to the OASSPI Message Group (see the MsgGrp 
column in the illustration below).

For any given problem, only the most recent error message is displayed (the older error 
message is automatically acknowledged). This reduces the number of error messages 
displayed in the message browser.
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WASSPI-1

WASSPI-2

Description Unable to create the lock file <filename>. File already exists.

Severity Critical

Help Text Probable Cause
Temporary lock files are used to avoid collisions if multiple OAS SPI data collector processes 
attempt to access the same data file. This error occurs when the lock file cannot be created 
after several attempts because the file already exists.
Suggested Action
If a file by the same name already exists, it may not have been deleted by a previous run of 
the OAS SPI data collector. You should delete this file manually.

Description Cannot access the SPI configuration.

Severity Critical

Help Text Probable Cause
A OAS SPI configuration file could not be located or accessed. Either the file does not exist or 
there was a problem reading the file.
Suggested Action
1 Verify that the collector template that runs the OAS SPI data collector specifies the 

correct directory on the command line. The option 
-Dwasspi.config.dir=<configDirectory> must be specified on command line invocation 
of the data collector. Refer to Managed Node File Locations on page 161 for configuration 
directory <configDirectory>.

2 Verify that the OAS SPI configuration files, SiteConfig and SPIConfig, are located in 
the directory specified on the command line in step 1. If not, run the OAS SPI 
configuration, accessed from the Application Bank J OASSPI J OASSPI Admin windows, to 
reinstall the files.

3 Refer to the text following the error message in the OAS SPI error log to help identify the 
underlying cause of the problem (for example, an I/O exception).You can view the OAS 
SPI error log for a managed node by using the View Error File application accessed 
from the Application Bank J OASSPI J OASSPI Admin windows. The error message can be 
identified by the date/time stamp.
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WASSPI-3

Description Error parsing command line.

Severity Critical

Help Text Probable Cause
The OAS SPI data collector command line is incorrectly specified in a collector template.
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

data collector command line syntax error. You can view the OAS SPI error log for a 
managed node by using the View Error File application accessed from the Application 
Bank J OASSPI J OASSPI Admin windows. The error message can be identified by the 
date/time stamp.

2 If the error occurred in a collector template that shipped with the OAS SPI, reinstall the 
OAS SPI.

3 If the error occurred in a collector template not shipped with the OAS SPI, correct the 
collector template that contains the incorrect command line. Refer to Using the OAS SPI 
Collector/Analyzer Command with Parameters on page 64 for more information on the 
OAS SPI data collector command line.
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WASSPI-4

WASSPI-5

Description Error getting the metric definitions.

Severity Critical

Help Text Probable Cause
The OAS SPI data collector could not read the metric definitions XML document. This error 
can be caused by a missing configuration property, an I/O error, an XML parsing error, a 
missing file, or a corrupted serialized data file.
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

underlying cause of the problem. You can view the OAS SPI error log for a managed node 
by using the View Error File application accessed from the Application Bank J OASSPI J 
OASSPI Admin windows. The error message can be identified by the date/time stamp.

2 If the UDM_DEFINITIONS_FILE property is missing from the OAS SPI configuration, 
reinstall the OAS SPI and run the Configure OASSPI application accessed from the 
Application Bank J OASSPI J OASSPI Admin windows.

3 If the problem is with the metric definitions file (MetricDefinitions.xml) that is 
shipped with the OAS SPI, then reinstall the OAS SPI. Run the Configure OASSPI 
application accessed from the Application Bank J OASSPI J OASSPI Admin windows.

4 If the problem is with a user-defined metric definitions file that is not shipped with the 
OAS SPI, verify that this XML file adheres to the MetricDefinitions.dtd 
specification. Refer to the HP OpenView Smart Plug-in User Defined Metrics User Guide 
for more information on writing user-defined metrics. Reinstall your user-defined metric 
definition file. Run the Configure OASSPI application, accessed from the Application Bank 
J OASSPI J OASSPI Admin windows, and verify that the UDM_DEFINITIONS_FILE 
property in the SPI configuration, is specified correctly.

5 If the underlying error is ClassNotFound, this is an internal error. Report this to your HP 
support representative.

Description Error processing metric <metric_number>.

Severity Major

Help Text Probable Cause
An error occurred while trying to collect data or perform calculations for the specified metric. 
Suggested Action
Refer to the text following the error message in the OAS SPI error log to help identify the 
underlying cause of the problem. The error messages previous to this one provide more 
information about the problem. You can view the OAS SPI error log for a managed node by 
using the View Error File application accessed from the Application Bank J OASSPI J OASSPI 
Admin windows. The error message can be identified by the date/time stamp.
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WASSPI-6

WASSPI-7

Description Required property <property_name> is missing from the OAS SPI configuration.

Severity Major

Help Text Probable Cause
A required property is missing from the OAS SPI configuration. 
Suggested Action
1 Run the Configure OASSPI application accessed from the Application Bank J OASSPI J 

OASSPI Admin windows. Verify that you have specified the correct server information for 
the Oracle OC4J/OHS servers on this managed node.

2 Verify that the property is specified correctly in the OAS SPI configuration file (/var/
opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed node 
in question.

Description Unable to contact server <server_name> at url=<URL>, port=<port>.

Severity Major

Help Text Probable Cause
The specified server is not running at the specified port.
Suggested Action
1 Run the Configure OASSPI application, accessed from the Application Bank J OASSPI J 

OASSPI Admin windows. Verify that you have specified the correct server name and port 
information for the Oracle OC4J/OHS servers on this managed node.

2 Verify that the properties, SERVER<n>_NAME and SERVER<n>_PORT, are specified correctly 
in the OAS SPI configuration file (
/var/opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed 
node in question.

3 Verify that the Oracle OC4J/OHS server is running on the managed node.
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WASSPI-8

WASSPI-9

Description Error saving graphing or reporting data to file <file_name>.

Severity Critical

Help Text Probable Cause
The specified graphing or reporting data file could not be found or an I/O error occurred 
when trying to access the file.
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

underlying cause of the problem. You can view the OAS SPI error log for a managed node 
by using the View Error File application accessed from the Application Bank J OASSPI 
J OASSPI Admin windows. The error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to 
Applications on page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.

Description Unable to retrieve property <property_name>.

Severity Critical

Help Text Probable Cause
A required property is missing from one of the OAS SPI configuration files. 
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

missing property. You can view the SPI error log for a managed node by using the View 
Error File application accessed from the Application Bank J OASSPI J OASSPI Admin 
windows. The error message can be identified by the date/time stamp.

2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 
OAS SPI configuration application. Verify that you have specified the correct information 
for the Oracle OC4J/OHS servers on the managed node in question.

3 Verify that the missing property is specified in the OAS SPI configuration file (/var/
opt/OV/wasspi/oas/conf/SiteConfig or
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) on the managed node 
in question.
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WASSPI-10

WASSPI-11

Description Encountered problem accessing file <filename>.

Severity Critical

Help Text Probable Cause
The specified file could not be found, created, or accessed. This file could be a temporary file. 
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

file in question and the underlying cause of the problem. You can view the OAS SPI error 
log for a managed node by using the View Error File application accessed from the 
Application Bank J OASSPI Admin J OASSPI Admin windows. The error message can be 
identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.

Description No servers have been specified in the OAS SPI configuration file. 

Severity Major

Help Text Probable Cause
The number of Oracle OC4J/OHS servers specified in the OAS SPI configuration for the 
managed node in question is 0.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPIto run the 

OAS SPI configuration application. Verify that you have specified the correct server name 
and port information for the Oracle OC4J/OHS servers on this managed node.

2 Verify that the property NUM_SERVERS in the OAS SPI configuration file (
/var/opt/OV/wasspi/oas/conf/SiteConfig or 
/var/opt/OV/conf/oas/SiteConfig on UNIX platforms or 
/usr/OV/wasspi/oas/conf/SiteConfig on Windows platforms) is set to the number 
of Oracle OC4J/OHS servers on this managed node.
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WASSPI-12

WASSPI-13

Description Opcmon returned an error code of <error_number> for the command <opcmon_command>. 

Severity Critical

Help Text Probable Cause
The opcmon process started by the OAS SPI collector has returned an error (non-zero) exit 
code.
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

3 Contact your HP support representative with the information gathered in the previous 
steps.

Description Exception occurred while running an opcmon process. 

Severity Critical

Help Text Probable Cause
The OAS SPI data collector attempted to run a process to execute an opcmon call. Either the 
process could not be created or was interrupted.
Suggested Action
For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are 
set high enough to allow process creation.
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WASSPI-14

WASSPI-15

Description Unable to find file <filename>. 

Severity Critical

Help Text Probable Cause
A file required by the OAS SPI data collector could not be found. 
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

file in question and the underlying cause of the problem.You can view the OAS SPI error 
log for a managed node by using the View Error File application accessed from the 
Application Bank J OASSPI J OASSPI Admin windows. The error message can be identified 
by the date/time stamp.

2 Reinstall the OAS SPI.
3 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPIto run the 

OAS SPI configuration application. 

Description Error parsing XML document <filename>. 

Severity Critical

Help Text Probable Cause
An error occurred while parsing the specified XML document. 
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

underlying cause of the problem. You can view the OAS SPI error log for a managed node 
by using the View Error File application accessed from the Application Bank J OASSPI J 
OASSPI Admin windows. The error message can be identified by the date/time stamp.

2 If the XML document was provided by the user, correct the document. Refer to the HP 
OpenView Smart Plug-in User Defined Metrics User Guide for more information about the 
correct format for a user-defined metric definition document.

3 If the XML document is a document that is shipped with the OAS SPI, from the 
Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the OAS SPI 
configuration application to reinstall the OAS SPI configuration files.
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WASSPI-16

WASSPI-18

Description A bad filter was specified for metric <metric_number>. 

Severity Major

Help Text Probable Cause
A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action
1 If the metric is specified in an XML document that was provided by the user, correct the 

document. Refer to the HP OpenView Smart Plug-in User Defined Metrics User Guide for 
more information about the correct format for a user-defined metric definition document.

2 If the metric is a pre-defined metric that is shipped with the OAS SPI, from the 
Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the OAS SPI 
configuration application in order to reinstall the OAS SPI configuration files.

Description Error logging to datasource <datasource_class_name>. Logging process returned exit code 
<exit_code>.

Severity Critical

Help Text Probable Cause
The ddflog process started by the OAS SPI data collector returned a non-zero error code. 
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to 
Applications on page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

3 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-19

WASSPI-20

WASSPI-21

Description Encountered problem instantiating XSLT transformer with <filename>. 

Severity Major

Help Text Probable Cause
The XSL document that specifies the auto action report output contains errors.
Suggested Action
1 Reinstall the OAS SPI.
2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 

Description Encountered problem creating report for metric <metric_number>. 

Severity Major

Help Text Probable Cause
An error occurred while producing a text report for the specified metric.
Suggested Action
1 Reinstall the OAS SPI.
2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 

Description Encountered problem instantiating factory implementation
'<class name>'.

Severity Critical

Help Text Probable Cause: The java property specifying the class name is incorrect or the class does 
not implement the AppServerFactory interface.
Suggested Action: Verify that the java property appserver.implementation is set to the 
fully qualified name of the class which implements the AppServerFactory interface. 
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WASSPI-23

WASSPI-24

Description Error initializing collector analyzer for server <server_name>.

Severity Critical

Help Text Probable Cause 
An exception was encountered while preparing to monitor the specified server.
Suggested Action 
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

problem. You can view the SPI error log for a managed node by using the View Error 
File application accessed from the Application Bank J OASSPI J OASSPI Admin windows. 
The error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank J OASSPI J OASSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous 
steps.

Description Error logging in to server <server_name> with login <login>.

Severity Critical

Help Text Probable Cause 
A security exception occurred while logging in to the specified server.
Suggested Action 
1 Run the Configure OASSPI application (by using the Configure OASSPI application 

accessed from the Application Bank J OASSPI J OASSPI Admin windows).
2 Verify that you have specfied the correct login and password on themanaged node on 

which the error occurred.
3 Verify the login has appropriate permissions.
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WASSPI-26

WASSPI-27

Description The data logging process for <server_name> timed-out.

Severity Major

Help Text Probable Cause 
Depending on your configuration, either OVPA or CODA failed to exit before the time-out.
Suggested Action 
1 Restart OVPA using the command mwa restart.
2 Restart CODA using the command opcagt -start.

Description RMI collector unable to process <command>.

Severity Warning

Help Text Probable Cause 
An exception was encountered while performing an rmid related operation.
Suggested Action 
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

problem. You can view the SPI error log for a managed node by using the View Error File 
application accessed from the Application Bank J OASSPI J OASSPI Admin windows. The 
error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank J OASSPI J OASSPI Admin windows).

5 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-30

WASSPI-31

WASSPI-32

WASSPI-33

Description Failed to start <rmid_path> on port <port>.

Severity Critical

Help Text Probable Cause 
The specified port is already in use.
Suggested Action 
1 Run the Configure OASSPI application (by using the Configure OASSPI application 

accessed from the Application Bank J OASSPI J OASSPI Admin windows) and set the 
RMID_PORT property to a port number which is not currently in use.

Description Lost connection to RMI collector while processing <command>.

Severity Warning

Help Text N/A

Description Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning

Help Text N/A

Description No actions matched server <server_name>, version <version>.

Severity Warning

Help Text Probable Cause 
JMXAction element(s) define FromVersion and ToVersion tags which do not match the server 
version.
Suggested Action 
If the action is valid on the server, then either modify the JMXAction definition’s 
FromVersion/ToVersion elements or modify the server’s VERSION property.
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WASSPI-34

WASSPI-35

WASSPI-36

Description Metric <metric_id> does not define any actions.

Severity Warning

Help Text Probable Cause 
The metric ID specified with the -m option does not define a JMXActions element.
Suggested Action 
Correct the -m option if an incorrect metric ID was specified. Otherwise, add a JMXActions 
definition to the metric definition.

Description Error executing action <action_command-line>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while executing the action.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description MBean <JMX_objectname> on server <server_name> does not expose operation 
<operation_name>.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action 
Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

WASSPI-38

WASSPI-39

Description MBean <JMX_objectname> on server <server_name> does not expose attribute 
<attribute_name> for write.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines a write attribute exposed by the specified MBean as 
read-only.
Suggested Action 
If the specified MBean is a custom MBean, update its management interface so that the 
attribute is writable. Otherwise, remove the attribute definition from the JMXCalls element.

Description MBean <JMX_objectname> on server <server_name> does not expose attribute 
<attribute_name>.

Severity Warning

Help Text Probable Cause 
An action’s JMXCalls element defines an attribute not exposed by the specified MBean 
ObjectName.
Suggested Action 
Correct the JMXCalls element or remove the attribute from the element.

Description Error invoking operation <operation_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while invoking an operation on the specified MBean. The 
managed resource may have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).
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WASSPI-40

WASSPI-41

WASSPI-42

Description Error setting attribute <attribute_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while setting an attribute on the specified MBean. The 
managed resource may have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description Error getting attribute <attribute_name> on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while getting an attribute from the specified MBean. The 
managed resource may have thrown an exception.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description Error running command <command>.

Severity Critical

Help Text Probable Cause 
A command started by the OAS SPI collector reported an error..
Suggested Action 
1 Identify the steps to reproduce the problem.
2 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

3 Run the Gather Info application (by using the Gather Info application accessed from the 
Application Bank J OASSPI J OASSPI Admin windows).

4 Contact your HP support representative with the information gathered in the previous 
steps.
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WASSPI-43

WASSPI-201

WASSPI-202

Description Error publishing event <event-type>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action 
View the managed node’s error log to determine the cause (follows the error message).

Description File <filename> not found.

Severity Critical

Help Text Probable Cause 
A configuration file could not be found.
Suggested Action 
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that the correct information has been specified for the Oracle OC4J/OHS servers on 

the managed node on which the error occurred.

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause

1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action

1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 
OAS SPI configuration application. 

2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 
on the managed node on which the error occurred.

3 Verify that the permissions are correct for the OVO user to read this file.
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WASSPI-203

WASSPI-204

WASSPI-205

Description Cannot write file <filename>.

Severity Critical

Help Text Probable Cause
Permissions may be incorrect, or a file or directory may be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
3 Verify that the permissions are correct for the OVO user to write this file.

Description Error sending opcmsg <message>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmsg. “opcmsg” may be missing or not have permissions to 
execute (OVO installation errors) or the system process table may be full.
Suggested Action
1 Confirm that OVO is properly installed and deployed to the managed node.
2 Ensure that the process table is not full. If it is, consider having the system administrator 

increase it.

Description Error sending opcmon <command>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmon. “opcmon” may be missing or not have permissions to 
execute (OVO installation errors) or the system process table may be full.
Suggested Action
1 Confirm that OVO is properly installed and deployed to the managed node.
2 Ensure that the process table is not full. If it is, consider having the system administrator 

increase it.
106 Chapter 6



WASSPI-206

WASSPI-207

WASSPI-208

Description Cannot read directory <directory>.

Severity Critical

Help Text Probable Cause
The permissions on the directory prevent the OVO user from reading it or the directory is 
corrupt.
Suggested Action
Verify that the permissions are correct for the OVO user for this directory.

Description Cannot move <filename> to <filename>.

Severity Critical

Help Text Probable Cause
1 Insufficient permissions.
2 Insufficient disk space.
3 File table problems.
Suggested Action
1 Verify that the permissions are correct for the OVO user.
2 Verify that there is enough disk space to create files.
3 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 

Description OASSPI must be configured before it can be used.

Severity Critical

Help Text Probable Cause
The OAS SPI has not been configured on this node.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
3 From the Application Bank, select OASSPI J OASSPI Admin J OASSPI Verify to run the 

verification application to confirm that the OAS SPI has been successfully configured.
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WASSPI-209

WASSPI-210

Description Cannot contact Oracle Application Server.

Severity Critical

Help Text Probable Cause
1 The server could be down or not responding.
2 The OAS SPI may be configured incorrectly.
Suggested Action
1 Verify that the Oracle OC4J/OHS server is up and running properly.
2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
3 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
4 From the Application Bank, select OASSPI J OASSPI Admin J OASSPI Verify to run the 

verification application to confirm that the OAS SPI has been successfully configured.

Description Cannot configure OASSPI.

Severity Critical

Help Text Probable Cause
The OAS SPI configuration process failed.
Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

underlying cause of the problem. The error messages previous to this one provide more 
information about the problem. You can view the OAS SPI error log for a managed node 
by using the View Error File application accessed from the Application Bank J OASSPI J 
OASSPI Admin windows. The error message can be identified by the date/time stamp.

2 Reinstall the OAS SPI.
3 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
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WASSPI-211

WASSPI-213

WASSPI-214

Description Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause
There are insufficient permissions for the OVO user to create the directory or there is 
insufficient disk space.
Suggested Action
Verify that the permissions are correct for the OVO user for this directory and verify that 
there is enough disk space.

Description  Improper parameters to program <name>. Usage: <usage>.

Severity Critical

Help Text Probable Cause
The parameters to the program are incorrect.
Suggested Action
Correct the parameters.

Description Cannot run program <program_name>.

Severity Critical

Help Text Probable Cause
The program failed to run. It may be missing, permissions may be incorrect, or the process 
table may be full.
Suggested Action
1 Verify that the file exists. If it is a OAS SPI program and the file is missing, reinstall the 

OAS SPI and, from the Application Bank, select OASSPI J OASSPI Admin J Configure 
OASSPI to run the OAS SPI configuration application.

2 Verify that the permissions are correct for the OVO user. 
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WASSPI-216

WASSPI-218

WASSPI-219

Description Configuration variable <name> missing for server <server_name>.

Severity Critical

Help Text Probable Cause
A required OAS SPI configuration property was not found.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that the correct information has been specified in the configuration for the 

managed node on which the error occurred. 

Description  Oracle Application Server monitoring has been turned OFF for <server_name>.

Severity Warning

Help Text Probable Cause
Collection has been turned off for the specified server.
Suggested Action
If desired, collection can be turned on by setting COLLECT = ON in the SiteConfig file in the 
OAS SPI configuration directory on the managed node. The configuration directory is /var/
opt/OV/wasspi/oas/conf/ or 
/var/opt/OV/conf/oas/ on UNIX platforms or 
/usr/OV/wasspi/oas/conf/ on Windows platforms. 

Description Oracle Application Server monitoring has been turned ON for <server_name>.

Severity Critical

Help Text Probable Cause
Collection has been turned on for the specified server.
Suggested Action
If desired, collection can be turned off by setting COLLECT = OFF in the SiteConfig file in 
the OAS SPI configuration directory on the managed node. The configuration directory is /
var/opt/OV/wasspi/oas/conf/ or 
/var/opt/OV/conf/oas/ on UNIX platforms or /usr/OV/wasspi/oas/conf/ on 
Windows platforms.
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WASSPI-221

WASSPI-222

Description <filename> does not exist.

Severity Critical

Help Text Probable Cause
The specified file does not exist. If it is a log file, no entries have ever been logged to it. If it is 
a property file, then it has not been configured.
Suggested Actions
• Log files - If there have never been any entries written to the file, no action is necessary. 

Otherwise, from the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI 
to run the OAS SPI configuration application.

• Property files - From the application bank, select OASSPI J OASSPI Admin J Configure 
OASSPI to run the OAS SPI configuration application.

Description <filename> is empty.

Severity Critical

Help Text Probable Cause
The specified file is empty. If it is a log file, no entries have ever been logged to it, or the 
entries have been cleaned out. If it is a property file, then it is not properly configured.
Suggested Action
• Log files - If there have never been any entries written to the file, no action is necessary. 

Otherwise, from the Application Bank, select 
OASSPI J OASSPI Admin J Configure OASSPI to run the OAS SPI configuration 
application.

• Property files - From the application bank, select OASSPI J OASSPI Admin J Configure 
OASSPI to run the OAS SPI configuration application.

• Configuration - From the application bank, select OASSPI J OASSPI Admin J Configure 
OASSPI to run the OAS SPI configuration application.
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WASSPI-223

WASSPI-224

Description Cannot read <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. Verify that you have specified the correct information 
for the Oracle OC4J/OHS servers on the managed node on which the error occurred.

2 Verify that the permissions are correct for the OVO user to read this file.

Description ddfcomp returned an error configuring <name>.

Severity Critical

Help Text Probable Cause
ddfcomp returned an error. Neither MeasureWare nor CODA is installed on the system or 
MeasureWare or CODA is not configured correctly.
Suggested Action
1 If MeasureWare and CODA are not installed, this error can be ignored.
2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application 

Bank J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to 
Applications on page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps. 
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WASSPI-225

WASSPI-226

WASSPI-227

Description No logfiles were found. Did you run OASSPI Config?

Severity Critical

Help Text Probable Cause
The logfile list is empty.
Suggested Action
1 Reinstall the OAS SPI.
2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that you have specified the correct information for the Oracle OC4J/OHS servers 

on the managed node on which the error occurred.
3 Verify that the permissions are correct for the OVO user to read this file.

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
No OpenView agent is installed on the system.
Suggested Action
If you should have a performance agent installed, reinstall the performance agent. 
Otherwise, this message can be ignored.
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WASSPI-228

WASSPI-229

Description ddflog returned an error logging <logfile-name>: <system-error-msg>

Severity Warning

Help Text Probable Cause
An error was returned by ddflog. This error could have been caused by the OAS SPI not 
being properly configured to support logging performance data.
Suggested Action
1 Try reconfiguring OAS SPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.

Description Cannot connect to directory <directory_name>

Severity Warning

Help Text Probable Cause
The directory does not exist or the user the agent is running under does not have appropriate 
permissions to the directory.
Suggested Action
If you should have a performance agent installed, reinstall the performance agent. 
Otherwise, this message can be ignored.
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WASSPI-230

WASSPI-231

WASSPI-232

Description Cannot get lock <filename> after <time-interval>

Severity Critical

Help Text Probable Cause
A OAS SPI process is hung or taking longer than expected.
Suggested Action
1 Stop the OVO agent on the managed node. Make sure all OVO and Oracle Application 

Server processes have stopped. 
2 Check if the lock file is still there. If it is, remove it. 
3 Restart the agent.

Description Cannot start the Java runtime engine.

Severity Critical

Help Text Probable Cause
1 The JAVA_HOME property in the SiteConfig file is not set correctly. 
2 Java is not properly installed on your system.
Suggested Action
1 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
2 Verify that you have specified the correct JAVA_HOME information on the managed node 

on which the error occurred.

Description Server <name> specified on command line, but not in configuration.

Severity Critical

Help Text Probable Cause
1 A -i or -e option was specified on the wasspi_oas_ca command line, but the server 

name specified is not configured in the SiteConfig file.
2 Java is not properly installed on your system.
Suggested Action
1 Specify a correct server name on the command line. 
2 From the Application Bank, select OASSPI J OASSPI Admin J Configure OASSPI to run the 

OAS SPI configuration application. 
3 Verify that you have specified the correct server names in the configuration.
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WASSPI-234

WASSPI-235

WASSPI-236

WASSPI-237

Description Error running program <file>, return value: <n>.

Severity Critical

Help Text Probable Cause
The SPI attempted to run the specified tool or auxiliary program and encountered an error 
(the return code is specified).
Suggested Action
• If the tool is a SPI tool, make sure the SPI is installed and configured correctly. If not, 

reinstall or reconfigure the SPI.
• If the tool is a system tool, make sure there are no system problems that prevent the tool 

from running. 

Description Restart of MeasurWare agent failed.

Severity Warning

Help Text Probable Cause
The SPI attempted to automatically restart the MeasureWare agent and the automatic 
attempt failed.
Suggested Action
Restart the MeasureWare agent manually using the command mwa restart server.

Description Failure when running XSLT on <xml> with stylesheet <xsl>:<message>.

Severity Critical

Help Text Probable Cause
The translation of the UDM XML failed (part of setting up graphing for user defined 
metrics).
Suggested Action
Review the specified message and verify the XML.

Description This is an informational message that an OV_PM or MeasureWare datasource was set up.

Severity Normal

Help Text N/A
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WASSPI-238

WASSPI-241

WASSPI-254

WASSPI-261

Description No user defined metrics found.

Severity Warning

Help Text Probable Cause
The UDM Graph Enable application was run, but no UDMs are defined.
Suggested Action
Verify that the UDM XML file is named correctly.

Description Cannot delete file <file>.

Severity Critical

Help Text Probable Cause
The SPI failed to delete the specified file.
Suggested Action
Verify the file’s permissions allow the user/system to delete the file.

Description Java exited with an error.

Severity Critical

Help Text Probable Cause
While running the collector or other java application, either Java encountered an error or the 
Java application exited with an error.
Suggested Action
Check for other errors generated at the same time and the SPI’s error log for clues about the 
cause of the problem.

Description XML Parse Error

Help Text Probable Cause
The wasspi_oas_XMLParser file may be missing or the XML may be malformed.
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WASSPI-262

WASSPI-263

WASSPI-261

WASSPI-601

Description Discovery Error

Help Text Probable Cause
Discovery failed. Review the errorlog and wasspi_oas_discovery.trc files on the 
managed node.

Description Windows Registry Error

Help Text Probable Cause
The Oracle Application Server installation may have failed or is not installed.

Description XML Parse Error

Help Text Probable Cause
The wasspi_oas_XMLParser may be missing or the XML may be malformed.

Description Retrieving OAS SPI configuration in OVO server

Severity Normal

Help Text Probable Cause
The managed node has requested a copy of the master SiteConfig file.
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WASSPI-602

WASSPI-603

Description Updating OAS SPI configuration in OVO server

Severity Normal

Help Text Probable Cause
This is a normal operation performed by the discovery application. 
If the operation is successful, the entry in the “A” (action) column for this message changes 
from “R” (running) to “S” (success).
Suggested Action
If the operation is not successful, the entry in the “A” (action) column for this message 
changes from “R” (running) to “F” (fail). Select this node and run the Discover OracleAS 
application. 
If the problem persists, configure the OAS SPI manually. Refer to Chapter 3, Configuring the 
OAS SPI for more information.

Description Updated OracleAS spi configuration in OVO server

Severity Normal

Help Text Probable Cause
The discovery application has discovered some OracleAS instances on the manged node. It 
has updated the OAS SPI configuration on the OVO management server.
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WASSPI-604

WASSPI-605

Description OracleAS Discovery Failed

Severity Critical

Help Text Probable Cause
• OracleAS was not installed on the managed node.
• There are no OracleAS instances running on the managed node.
• Discovery needs more information to find all OracleAS instances running on the managed 

node.
• The OAS SPI does not have the correct configuration information for the OracleAS 

instances.
Suggested Action
• Install OracleAS or verify that OracleAS is installed on the managed node.
• Make sure that all OracleAS instances you want to monitor are up and running before 

running the Discover OracleAS application. Discovery only finds OracleAS instances that 
are running. Verify the servers are running from the OracleAS Control Console.

• Run the Configure OASSPI application (be sure to select the managed node before 
starting the application) and set the HOME_LIST property. Then, run the Discover 
OracleAS application.

• Verify the information set for the following properties: LOGIN, PASSWORD, NAME, and 
HOME_LIST. If you modify information for any of these properties, run he Discover 
OracleAS application.

If the problem persists, configure the OAS SPI manually. Refer to Chapter 3, Configuring the 
OAS SPI for more information.

If manual configuration fails, run the SHS application accessed from the Application Bank J 
OASSPI J OASSPI Admin windows. Contact your HP support representative with the 
gathered information. 

Description Could not find OAS home directory: <directory>

Severity Critical

Help Text Probable Cause
The specified directory was set in the HOME_LIST property but the directory does not exist.
Suggested Action
1 Verify that the directory exists on the managed node. 
2 Use the Configure OASSPI application to verify that the HOME_LIST property contains 

the specified directory and modify the value.
3 Run the Discover OracleAS application.
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WASSPI-606

All Other Errors

Description OracleAS version not found

Severity Critical

Help Text Probable Cause
The OraclesAS version string was not found. OracleAS may not be installed on the managed 
node.
Suggested Action
Install OracleAS or verify that OracleAS is installed on the managed node.

Description An unknown error appears in the OAS SPI error log.

Severity Major

Help Text Suggested Action
1 Refer to the text following the error message in the OAS SPI error log to help identify the 

problem. You can view the SPI error log for a managed node by using the View Error File 
application accessed from the Application Bank J OASSPI J OASSPI Admin windows. The 
error message can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing (by using the Start Tracing application accessed from the Application Bank 
J OASSPI J OASSPI Admin windows) and reproduce the problem. Refer to Applications on 
page 17 for more information about available applications.

Tracing information is saved to /<OvAgentDir>/wasspi/oas/log/trace.log 
(archived files have a three digit number appended to the filename) where /
<OvAgentDir>/ is typically /var/opt/OV/.

4 Contact your HP support representative with the information gathered in the previous 
steps.
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A File Locations
You can find OAS SPI configuration files and error logs in specific directories.

OVO Management Server File Locations  

Managed Node File Locations

On DCE-based managed nodes, HTTPS Windows managed nodes, or UNIX managed nodes 
that were already running the OAS SPI and are being switched to a non-root HTTPS agent 
environment (UNIX only: if these directories do not exist, refer to the next table for file 
locations): 

Operating System File File Location

HP-UX Configuration /opt/OV/wasspi/oas/conf

Solaris Configuration /opt/OV/wasspi/oas/conf

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/wasspi/oas/conf

HP-UX, Solaris, Linux Error Logs /var/opt/OV/wasspi/oas/log

AIX Configuration /var/lpp/OV/wasspi/oas/conf

AIX Error Logs /var/lpp/OV/wasspi/oas/log

Windows (DCE) Configuration \usr\ov\wasspi\oas\conf

Windows (DCE)  Error Logs \usr\ov\wasspi\oas\log

Windows (HTTPS) Configuration \Program Files\HP 
OpenView\data\wasspi\oas\conf

Windows (HTTPS)  Error Logs \Program Files\HP 
OpenView\data\wasspi\oas\log
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On newly configured OAS SPI managed nodes in the non-root HTTPS agent environment 
(UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/conf/oasspi

HP-UX, Solaris, Linux Error Logs /var/opt/OV/log/oasspi

AIX Configuration /var/lpp/OV/conf/oasspi

AIX Error Logs /var/lpp/OV/log/oasspi
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B The Configuration 
This appendix contains information about the configuration structure, how to use the 
configuration editor, descriptions of the configuration properties, and samples of the 
configuration.

Structure

See Sample Configurations on page 141 for examples of the configuration. The basic structure 
of the configuration is (lines preceded by # are treated as comments and are ignored):

# Global Properties
property=<value> ...

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

# NODE Block
NODE <node_name | group_name>
{
property=<value> ...
}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can 
be overridden by properties set within a GROUP or NODE block or by server-specific 
properties.

GROUP Block

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block 
<group_name> is repeated within the configuration, the last definition takes precedence.

<node_name> lists the nodes in the group and is the primary node name configured in OVO.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the 
Default Properties item in the <Group_Name> folder.

NODE Block

# NODE Block
NODE <node_name | group_name>
{
<property>=<value> ...
}

Properties set in a NODE block apply to nodes belonging to the group defined by 
<group_name> (to set common properties for a group) or to the specified <node_name> (to set 
properties for a single node).

For a group, enter the <group_name> defined by the GROUP block and define the group’s 
common properties.

For a single node, enter the <node_name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes 
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the 
Default Properties item in the <Node_Name> folder.

Server-Specific Properties

Each property specified as SERVER<n>_property refers to a specific Oracle OC4J/OHS server 
instance. When more than one Oracle OC4J/OHS server instance is running on a given 
managed node, the number <n> differentiates the servers. Numbering begins at “1” and each 
Oracle OC4J/OHS server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:

1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 <property> (global property)

The node name specified in a GROUP block matches the value returned by the OVO variable 
$OPC_NODES, which is the primary node name configured in OVO.
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Using the Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the 
configuration using this editor only.

The main features of the configuration editor are:

• Tree

• Buttons

• Actions

Configure OASSPI - Tree

The Configure OASSPI tree, displayed in the left pane of the Configure OASSPI application’s 
main window, displays the OAS SPI configuration in a tree structure.

The following is an example of the tree.

.

where the icons are defined as follows:

If no OC4J/OHS servers or groups are configured, the “OC4J/OHS Servers” and “Groups” 
folders are not displayed. If you are running Configure OASSPI for the first time and you did 
not select any nodes before you launched the tool, the “Nodes” folder is not displayed

The configuration properties can be viewed.

The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name Description

OC4J/OHS Servers A folder that contains a list of all the OC4J/OHS servers. This 
folder can appear under Defaults (global properties), 
Group_Name(s) (GROUP block), or Node_Name(s) (NODE 
block).

<OC4J/OHS_Server_Name> The name of the OC4J/OHS server.

Configuration A folder that contains all OAS SPI configuration information 
for the Oracle Application Server environment.

Default Properties Lists the configuration properties that have been set. This item 
appears under Defaults (global properties), Group_Name(s) 
(GROUP block), or Node_Name(s) (NODE block).

Defaults A folder that represents the global properties. Default 
properties set at this level apply to all nodes. However, these 
properties can be overridden by properties set under the 
Group_Name and Node_Name folders (refer to Property 
Precedence on page 126 for more information).

Groups A folder that represents the GROUP block.

<Group_Name> A folder that identifies the name of a group of nodes with 
common properties. Default properties set at this level apply to 
all nodes that belong to the specified group. These properties 
can be overridden by properties set under the Node_Name 
folders (refer to Property Precedence on page 126 for more 
information).

Nodes A folder that represents the NODE block.

<Node_Name> A folder that represents a single node whose name matches the 
value returned by the OVO variable $OPC_NODES, which is the 
primary node name configured in OVO. Default properties set 
at this level apply to the specified node only (refer to Property 
Precedence on page 126 for more information).
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Configure OASSPI - Buttons

The following buttons are available in Configure OASSPI:

Configure OASSPI - Actions

Actions that you can perform depend upon the item that is selected in the tree and from where 
you access the action. The following actions can be accessed from the Actions menu, File 
menu, or by right-clicking on an item in the tree. 

Button Description

Cancel Exit Configure OASSPI.
If you set configuration properties without saving them, these changes 
are not saved.
If you added or removed an OC4J/OHS server, node, or group without 
saving the change or if you modified a configuration property, a Confirm 
Cancel window opens. Click Save and Exit to save the changes before 
exiting, Exit without Save to exit without saving the changes, or Return to 
Editing to continue editing the configuration (changes are not saved).

Finish Exit Configure OASSPI. Appears instead of Next if you launched 
Configure OASSPI without selecting any nodes.

Next Exit Configure OASSPI. Takes you to the “Confirm Operation” window 
that lists the nodes you selected before you started Configure OASSPI. 
The selected managed nodes’ configurations are updated with your 
changes. If you made changes to nodes that were not selected (are not 
displayed in the “Confirm Operation” window), the changes are saved to 
the OVO management server’s configuration, but to make the changes 
to those managed node’s configuration, you must select those managed 
nodes from the node bank, restart Configure OASSPI, and then exit.

Save Save changes to the OVO management server’s configuration and 
continue editing the configuration. You may also select File J Save to 
save your changes.

Action Description Selected Tree Item

Add OC4J/OHS Server Add an OC4J/OHS server. See Add 
OC4J/OHS Server on page 130 for 
more information.

OC4J/OHS Servers
Defaults
<Group_Name>
<Node_Name>

Add Group Create a group to which you can 
assign nodes that have common 
properties. See Add Group on 
page 131 for more information.

Any item in the tree
Any item in the tree

Add Node Add a managed node to the Nodes 
folder. See Add Node on page 131 for 
more information.

Any item in the tree
Any item in the tree
The Configuration 129



Add OC4J/OHS Server

Add an Oracle OC4J/OHS Server instance at the global properties, GROUP, or NODE level in 
the OAS SPI configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you are 
prompted to set the ALIAS property (to uniquely identify each server). Refer to Property 
Definitions on page 137 for more information about the ALIAS property.

To add an OC4J/OHS server, do the following:

1 Right-click one of the following items in the tree: Defaults (global properties level), OC4J/
OHS Servers (global properties level), <Group_Name> (GROUP level), or <Node_Name> 
(NODE level) and select Add OC4J/OHS Server.

The Configure OASSPI Application: Add OC4J/OHS Server window opens.

Exit Exit the Configure OASSPI 
application. This action is available 
from the File menu. If any changes 
were made that have not been saved, 
the Confirm Cancel window opens.

Any item in the tree
Any item in the tree

Remove OC4J/OHS 
Server/Remove ALL 
OC4J/OHS Servers

Remove an OC4J/OHS server or all 
listed OC4J/OHS servers. See 
Remove OC4J/OHS Server/Remove 
ALL OC4J/OHS Servers on page 132 
for more information.

OC4J/OHS Servers
<OC4J/

OHS_Server_Name>

Remove Group/Remove 
ALL Groups

Remove a OAS SPI group or all 
listed OAS SPI groups. See Remove 
Group/Remove ALL Groups on 
page 132 for more information.

Groups
<Group_Name>

Remove Node/Remove 
ALL Nodes

Remove a managed node or remove 
all managed nodes. See Remove 
Node/Remove ALL Nodes on 
page 133 for more information.

Nodes
<Node_Name>

Save Save changes to the configuration. 
This action is available from the File 
menu only if changes were made to 
the configuration.

Any item in the tree
Any item in the tree

Set Configuration 
Properties tab

Set OAS SPI configuration 
properties. See Set Configuration 
Settings Tab on page 133 for more 
information.

<OC4J/
OHS_Server_Name>

Default Properties

View Configuration 
Settings tab

View OAS SPI configuration 
properties. See View Configuration 
Settings Tab on page 134 for more 
information.

Any item in the tree
Any item in the tree

Action Description Selected Tree Item
130 Appendix B



2 Enter the “OC4J/OHS Server Name.” This is the name of the OC4J/OHS server as defined 
in the Oracle Application Server and is case-sensitive. The Oracle Application Server 
Control Console displays the server names of all configured OC4J/OHS servers in a 
domain. Use these names for the OC4J/OHS Server Name.

3 Click OK.

The NAME property is set.

The OC4J/OHS server is added and its properties are displayed. You may also set 
additional configuration properties for this server. See Set Configuration Settings Tab on 
page 133 for more information.

4 Click Save to save your changes.

If you do not want to add this OC4J/OHS server, right-click the OC4J/OHS server name, 
select Remove OC4J/OHS Server, and click Save.

Add Group

Assign nodes to a group that have common properties in the OAS SPI configuration.

To add a group, do the following:

1 Right-click any item in the tree and select Add Group.

The Configure OASSPI Application: Add Group window opens.

2 Enter the Group Name. The group name identifies the group of nodes with common 
properties and is NOT case-sensitive.

3 Click OK.

The group is added and the Set Configuration Properties tab for the group is selected.

4 Select Add Node to Group, select one node from the list to add to the group, and click OK. 
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set pulldown 
list. See Set Configuration Settings Tab on page 133 for more information.

6 Click Save to save your changes.

If you do not want to add the group, right-click the group name, select Remove Group, and 
click Save.

Add Node

Add a managed node to the OAS SPI configuration.

To add a node, do the following:

1 Right-click any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the following 
message appears:

All available managed nodes have been added to the configuration. 

Click OK to exit this action.

Otherwise, the Configure OASSPI Application: Add Node window opens.

2 From the pulldown menu, select a node to add.

3 Click OK.
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The node is added and the Set Configuration Properties tab for the node displays.

4 Set the configuration properties for this node using the Select a Property to Set pulldown 
list. See Set Configuration Settings Tab on page 133 for more information.

5 Click Save to save your changes.

If you do not want to add the node, right-click the node name, select Remove Node, and 
click Save.

Remove OC4J/OHS Server/Remove ALL OC4J/OHS Servers

Remove an OC4J/OHS Server or all listed OC4J/OHS Servers from the OAS SPI 
configuration.

To remove an OC4J/OHS server, do the following:

1 Right-click the OC4J/OHS server name and select Remove OC4J/OHS Server.

The selected OC4J/OHS server name is removed from the list and its configuration 
properties are removed from the configuration.

2 Click Save to permanently remove the OC4J/OHS server.

Click Cancel to cancel the removal of the OC4J/OHS server (the OC4J/OHS server name 
appears the next time you run Configure OASSPI). In the Confirm Cancel window, click 
Exit without Save.

To remove ALL OC4J/OHS servers, do the following:

1 Right-click the OC4J/OHS Servers folder and select Remove ALL OC4J/OHS Servers.

The selected OC4J/OHS Servers folder and all OC4J/OHS servers listed in the selected 
folder are removed (all configuration properties for the listed OC4J/OHS servers are 
removed from the configuration).

2 Click Save to permanently remove the OC4J/OHS servers.

Click Cancel to cancel the removal of all OC4J/OHS servers (the OC4J/OHS Servers folder 
and all OC4J/OHS server names listed in the folder appear the next time you run 
Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

Remove Group/Remove ALL Groups

Remove a OAS SPI group or all listed OAS SPI groups from the OAS SPI configuration.

To remove a group, do the following:

1 Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you 
run Configure OASSPI). In the Confirm Cancel window, click Exit without Save.
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Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the OAS SPI configuration.

To remove a node, do the following:

1 Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the node.

Click Cancel to cancel the removal of the node (the node name appears the next time you 
run Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

To remove ALL nodes, do the following:

1 Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all 
configuration properties for the listed nodes are removed from the configuration).

2 Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed 
in the folder appear the next time you run Configure OASSPI). In the Confirm Cancel 
window, click Exit without Save.

Set Configuration Settings Tab

Set OAS SPI configuration properties at the global properties level or for the selected OC4J/
OHS server(s), group(s) (GROUP level), or node(s) (NODE level).

Items with the  icon are the only items for which you can set configuration properties 
(Default Properties and <OC4J/OHS_Server_Name>).

To set the configuration properties of an item, select the item and click the Set Configuration 
Properties tab in the right pane.

Setting a Property

To set a property in the configuration, do the following:

1 Select a property from the Select a Property to Set pulldown menu.

2 Select Set Property. The property and an empty value filed appear in the table.

3 Click the empty value field and enter a value.

4 Repeat steps 1 - 3 for each property to set.

5 Click Save.

See Configuration Properties on page 135 for more information about individual properties.

Modifying a Property

To modify a property in the configuration, do the following:

1 Select the property from the table.

2 Double-click the value field.

3 Edit the value.
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4 If a node contains duplicate server names (the NAME property is set to the same value), you 
are prompted to set the ALIAS property (to uniquely identify each server). Refer to 
Property Definitions on page 137 for more information about the ALIAS property.

5 Repeat steps 1 - 3 for each property to modify.

6 Click Save.

See Configuration Properties on page 135 for more information about individual properties.

Removing a Property

To remove a property from the configuration, do the following:

1 Select the property from the table.

2 Click Remove Property.

3 Repeat steps 1 - 2 for each property to remove.

4 Click Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the 
AUTO_DISCOVER property. You can only set this property by selecting or unselecting the 
check box.

Selecting the check box (default) causes the discovery templates (if distributed) to 
automatically update the OAS SPI configuration information in the service map and 
configuration. If the discovery templates are not distributed, the service map is created but 
not updated.

View Configuration Settings Tab

View all OAS SPI configuration properties set in the configuration on the OVO management 
server or the OAS SPI configuration properties for the selected OC4J/OHS server(s), group(s), 
or node(s).

To view the configuration properties of an item, select the item and click the View Configuration 
Settings tab in the right pane.

The following table describes the view when the specified item is selected.

Item Name Description of View

OC4J/OHS Servers View all configuration properties set for all the listed 
OC4J/OHS servers.

<OC4J/OHS_Server_Name> View all configuration properties set for the OC4J/OHS 
server (these properties can be modified by selecting the 
Set Configuration Properties tab).

Configurations View all configuration properties saved in the 
configuration on the OVO management server.

Default Properties View all configuration properties that are set (these 
properties can be modified by selecting the Set 
Configuration Properties tab).

Defaults View all configuration properties set at the global 
properties level.
134 Appendix B



View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting 
this check box, the view of the configuration properties changes to show all inherited 
properties (those properties defined at a global properties level or GROUP level) that affect 
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By unselecting this check box, the view shows only the configuration properties set at that 
level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after the 
property, the property cannot be modified at that level. For example, if the property HOME is 
set at the global properties level (under the Defaults folder), it can only be modified in the 
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after 
it) in a <Group_Name>’s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree. 
For example, if the property HOME is set at the global properties level (under the Defaults 
folder) and the property HOME is set at the GROUP level, the GROUP level property value 
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest:

1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level

Configuration Properties 

Table 4 on page 136 lists all properties by OAS SPI requirements, where: 

Groups View all configuration properties set for all the listed 
groups.

<Group_Name> View all configuration properties set for the specific 
group.

Nodes View all configuration properties set for the listed 
nodes.

<Node_Name> View all configuration properties set for the specific 
node.

Item Name Description of View

Property Name of the property.

Requirements Lists the property requirements for specific components where:

R - Required: the property must be set.

C - Conditional: the property may need to be set if certain 
conditions are met.
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Refer to Configuration Properties on page 135 for a description of the property.

O - Optional: the property is not required for the component 
to work.

blank - Not Applicable: the property does not affect this 
component.

OAS SPI Configuration requirements for the OAS SPI to work.

Discovery 
Process

Requirements for the discover process to work.

Auto-Discovered The property is automatically set by the discover process.

Level of 
Configuration

The level at which this property can be set within the configuration 
structure.

Default 
Properties

The global, group, or node level within the configuration structure.

Application 
Server

The server-specific level within the configuration structure.

Table 4 Properties Listed by OAS SPI Requirements

Property

Requirements

Auto-
Discovered

Level of Configuration

OAS SPI
Discovery 
Process

Default 
Properties

Application 
Server

HOME R C

JAVA_HOME R

NAME R

ALIAS C

AUTO_DISCOVER C C

GRAPH_URL C

RMID_PORT C

RMID_START_TIME C

START_CMD C

STOP_CMD C

TYPE C

USER C
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Property Definitions

VERSION C

MAX_ERROR_LOG_
SIZE

O

TIMEOUT O

Table 4 Properties Listed by OAS SPI Requirements

Property

Requirements

Auto-
Discovered

Level of Configuration

OAS SPI
Discovery 
Process

Default 
Properties

Application 
Server

Table 5 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description

ALIAS 9.04, 
10.1.2

Conditional
Required if more 
than one 
application 
server on a 
system share the 
same server 
name.

Unique name on a managed node assigned to 
an OC4J/OHS server if more than one OC4J/
OHS server on a system share the same server 
name. The alias, if set, is the name used in 
messages, reports, and graphs (otherwise, NAME 
is used).
If ALIAS is modified, the data for the old alias 
is saved but is not mapped to the new alias.
Example: 
NODE petstore.hp.com {
SERVER1_NAME=dog
SERVER1_ALIAS=beagle
SERVER2_NAME=dog
SERVER2_ALIAS=dachshund 

}

NODE flying_ace.hp.com {
SERVER1_NAME=snoopy
SERVER1_ALIAS=beagle
SERVER2_NAME=snoopy
SERVER2_ALIAS=red_baron 

}
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AUTO_DISCOVER 9.04, 
10.1.2

Conditional
Required if you 
do not want the 
discovery policy 
to automatically 
overwrite the 
configuration 
information.

Select the AUTO_DISCOVER check box in the 
configuration editor to automatically update 
the Oracle Application Server configuration 
information in the service map and 
configuration. 
Unselect the AUTO_DISCOVER check box in 
the configuration editor if you are manually 
configuring the Oracle Application Server 
configuration and do not want the discovery 
template to automatically overwrite the 
configuration information. 

GRAPH_URL 9.04, 
10.1.2

Conditional
Required if you 
want to use the 
View Graphs 
application 
(OVPM must be 
installed).

The fully-qualified URL used to launch OVPM. 
Set at the global level only.
Examples: GRAPH_URL = http://
system1.hp.com/HPOV_Reports/ovpm.htm 
(OVPM 4 on Windows)
GRAPH_URL = http://system2.hp.com:8080/
OVPM/index.html (OVPM 5 on UNIX and 
Windows)

HOME 9.04, 
10.1.2

Required The directory where the Oracle Application 
Server is installed. 
Example: 
HOME = /opt/oracle/infra

JAVA_HOME 9.04, 
10.1.2

Required
Required by the 
discovery process 
if there is more 
than one 
directory where 
Java is installed.

The directory where Java is installed that is 
used by the collector. The java engine is 
expected to be $JAVA_HOME/bin/java.
Example: JAVA_HOME = /opt/oracle/jdk

MAX_ERROR_LOG_SIZE 9.04, 
10.1.2

Optional The maximum number of MB allowed for the 
error log file. When the error log file reaches 
the maximum limit, it is renamed as a backup 
file and logging resumes. When a new backup 
file replaces an old backup file, the old backup 
is deleted.
Default: 2MB
Example: 
MAX_ERROR_LOG_SIZE = 20

Table 5 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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NAME 9.04, 
10.1.2

Required The OC4J instance name. Use the dcmctl 
listInstances command to display all Oracle 
Application Server instances.

This name is used in messages, reports, and 
graphs unless ALIAS is set. Set ALIAS to 
uniquely identify each server if more than one 
OC4J/OHS server on a system share the same 
name (NAME is the same within a NODE block). 
Example: SERVER1_NAME = exampleServer

RMID_PORT 9.04, 
10.1.2

Conditional
Required if the 
default port on 
which rmid 
listens is already 
in use.

Default: Oracle Application Server: 9240; JMX 
connector: 9241
The port on which rmid listens. By default, if 
an OVO managed node is monitoring 
application server(s) and MBean server(s) 
using the JMX connector, the SPI uses two 
ports (one for the application server(s) and one 
for the MBean server(s)). For example, if you 
are monitoring an Oracle Application Server 
and an MBean server, the SPI uses ports 9240 
and 9241. If RMID_PORT is set, the SPI uses 
this one port for all servers (this property 
cannot be set at the application server level). 
For example, if you are monitoring a Oracle 
Application Server and an MBean server and 
set RMID_PORT to 9250, the SPI uses port 
9250 only.
Example: RMID_PORT = 9250 

RMID_START_TIME 9.04, 
10.1.2

Conditional
Required if rmid 
takes longer than 
30 seconds to 
start.

Default: 30 (seconds)
The amount of time, in seconds, to wait for 
rmid to start before timing out.
Example: RMID_START_TIME = 60

START_CMD 9.04, 
10.1.2

Conditional
Required if you 
want to start the 
Oracle 
Application 
Server from the 
OVO console

A fully qualified system command that is run 
when the OVO Application Bank “Start 
OracleAS” application is used. This command 
is run by USER which must be set in order for 
the “Start OracleAS” application to work. 
NOTE: This command must exit. That is, the 
Oracle Application Server process must run in 
the background or as a service and it must be 
protected from its parent process dying. 
Example: SERVER1_START_CMD = 
/sbin/init.d/oracle start

Table 5 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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STOP_CMD 9.04, 
10.1.2

Conditional
Required if you 
want to stop the 
Oracle 
Application 
Server from the 
OVO console

A fully qualified system command that is run 
when the OVO Application Bank “Stop 
OracleAS” application is used. This command 
is run by USER which must be configured in 
order for the “Stop OracleAS” application to 
work. 
Example: SERVER1_STOP_CMD = 
/sbin/init.d/oracle stop

TIMEOUT 9.04, 
10.1.2

Optional Default: 120 (seconds). The maximum amount 
of time, in seconds, OAS SPI tries to connect to 
the Oracle Application Server. When the 
specified time is exceeded, OAS SPI sends an 
alarm to the message browser indicating that 
the Oracle Application Server is unavailable. If 
metric C002_ServerStatusRep is being 
collected, the unavailability of the server is 
logged. 
If no time limit is desired, set this property to 
-1. 

TYPE 9.04, 
10.1.2

Conditional
Required if you 
are configuring a 
JMX connector

Default: ajp13. The type of JMX connector. Set 
to ajp13 if this is an OC4J server. Set to ohs if 
this is an OHS (HTTP_Server) server. Set to 
ovrmi if you are configuring a JMX connector.
Example: SERVER1_TYPE=ajp13

USER 9.04, 
10.1.2

Conditional
Required if you 
want to start and/
or stop the Oracle 
Application 
Server from the 
OVO console

The system username for starting and stopping 
the Oracle Application Server from the OVO 
Application Bank. 
The default is the username under which the 
OVO agent runs.
Example: USER = ias_admin

VERSION 9.04, 
10.1.2

Conditional
Required for 
Oracle 
Application 
Server version 
10.1.2

The version number of the Oracle Application 
Server in the format Major# [Minor#] where:
Major# - The primary version number (for 
example, 10.1) 
Minor# - The service pack installed (for 
example, 1 for SP1). If Minor# is not specified, 
it defaults to 0 (no service pack installed).
Example: SERVER1_VERSION = 10.1 2

Table 5 Configuration Properties

Property
Applicable 
OAS Version

Required/
Conditional/
Optional Description
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Sample Configurations

The sample OAS SPI configurations with entries contained in this appendix illustrate various 
features and utilization methods.

Example 1: Single Node/Two Servers

The example below is for a single node running two servers: an OC4J and HTTP servers. The 
properties HOME, JAVA_HOME, MAP_KEY_PREFIX, and VERSION are global defaults 
that apply to all servers and nodes. 

HOME=C:/OraHome_1
JAVA_HOME=C:/OraHome/jdk
MAP_KEY_PREFIX=
VERSION=10.1 2
NUM_SERVERS=2
NODE some_node.hp.com
{
SERVER1_NAME=HTTP_Server
SERVER1_TYPE=ohs
SERVER2_NAME=home
SERVER2_TYPE=ajp13

}

Example 2: Multiple Nodes/Repeated Properties

The example that follows shows how you can configure a group of related systems that have 
numerous properties in common. Some nodes, however, may have one or two properties that 
you need to set differently. You can address these kinds of situations in three steps: 

1 Use the Add Group action in the configuration editor to name the group, specify the nodes 
in it, and set the configuration properties. See Add Group on page 131 for more 
information.

2 Use the Add Node action in the configuration editor to define individual node properties 
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). See Add Node on page 131 for more information.

In the example, the global default properties HOME, JAVA_HOME, and MAP_KEY_PREFIX are 
overridden for SERVER4 and SERVER5 of the node group “production” and for node 
europa.hp.com. 

HOME = /opt/oracle/appsrv
JAVA_HOME = /opt/oracle/appsrv/jdk
MAP_KEY_PREFIX = /appsrv.hp.com
VERSION = 10.1 2
GROUP production
{
mercury.hp.com
venus.hp.com

Properties set for a node take precedence over the same properties set for a group. See 
Property Precedence on page 126 for the complete order of property precedence.
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mars.hp.com
jupiter.hp.com

}
NODE production
{
SERVER1_NAME = HTTP_Server
SERVER1_TYPE = ohs
SERVER1_ALIAS = HTTP_Server+appsrv.hp.com
SERVER2_NAME = OC4J_Portal
SERVER2_TYPE = ajp13
SERVER3_NAME = home
SERVER3_TYPE = ajp13
SERVER4_NAME = HTTP_Server
SERVER4_TYPE = ohs
SERVER4_ALIAS = HTTP_Server+infra.hp.com
SERVER4_HOME = /opt/oracle/infra
SERVER4_JAVA_HOME = /opt/oracle/infra/jdk
SERVER4_MAP_KEY_PREFIX = /oasspi/infra.hp.com
SERVER5_NAME = OC4J_SECURITY
SERVER5_TYPE = ajp13
SERVER5_HOME = /opt/oracle/infra
SERVER5_JAVA_HOME = /opt/oracle/infra/jdk
SERVER5_MAP_KEY_PREFIX = /oasspi/infra.hp.com

}
NODE europa.hp.com
{
SERVER1_NAME = OC4J_SECURITY
SERVER1_TYPE = ajp13
SERVER1_HOME = /opt/oracle/infra
SERVER1_JAVA_HOME = /opt/oracle/infra/jdk
SERVER1_MAP_KEY_PREFIX = /oasspi/infra.hp.com

}
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C Applications
The Smart Plug-in for Oracle Application Server (OAS SPI) applications include configuration 
and troubleshooting utilities.

OASSPI Admin applications include:

• Configure OASSPI

• Discover OracleAS

• Init Non-Root

• Self-Healing Info

• Start/Stop Monitoring

• Start/Stop Tracing

• Verify

• View Error File

• View Graphs

OracleAS applications include:

• Launch Oracle AS Console

• Start/Stop OracleAS

• View OAS Logs

• View Status
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OASSPI Admin

The following applications are found in the OASSPI Admin application group. 

Configure OASSPI

Launches the configuration editor and maintains the OAS SPI configuration.

If you are configuring OAS SPI for the first time, use the Discover OracleAS application to 
automatically set basic configuration properties. Refer to Chapter 3, Configuring the OAS SPI 
for more information.

Purpose

Launches the configuration editor allowing the OVO administrator to maintain the OAS SPI 
configuration by viewing, editing, or setting configuration properties.

Function

Configure OASSPI does the following:

• Updates the configuration on the OVO management server and managed nodes.

• Creates the directories and files required by OAS SPI on the selected managed nodes.

• Sets up data sources for reporting and graphing

• Sets up the Oracle Application Server log files and OAS SPI error log file for monitoring

Configuration information for all Oracle Application Servers on all OVO managed nodes is 
maintained on the OVO management server. Configuration information for a specific Oracle 
Application Server on an OVO managed node is maintained on that managed node (each 
managed node maintains a subset of the configuration information maintained on the OVO 
management server).

When saved, changes made with the configuration editor are always saved on the OVO 
management server.

If a specific OVO managed node is selected when this application is launched, changes to the 
configuration affecting any Oracle Application Servers on that managed node are 
automatically saved on that managed node.

If no managed nodes are selected when this application is launched, changes to the 
configuration are not saved on any managed nodes.

If a specific OVO managed node is selected when this application is launched and changes are 
made that affect an Oracle Application Server on a non-selected managed node, the changes 
are saved to the configuration on the OVO management server, but are not saved to the 
non-selected managed node. You must select the affected managed node, re-run this 
application, and, upon exiting the application, the changes are saved to the managed node.

To Launch Configure OASSPI

1 At the OVO console, select the node(s) in the Node Bank window. 

2 Select Application Bank.
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3 In the Application Bank window select OASSPI J OASSPI Admin J Configure OASSPI. (If 
the items do not appear, select Map J Reload.)

4 The Introduction window opens. 

Click Next.

5 The configuration editor opens. Refer to Using the Configuration Editor on page 165 for 
more information about using the configuration editor.

6 Optionally, click Save to save any changes made to the configuration. Once you save your 
changes, you cannot automatically undo them.

7 Click Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Click OK.

8 If you have added an application server or added/edited the HOME and/or JAVA_HOME 
properties, run the Discover OracleAS application on the managed nodes on which the 
application server/properties were added or edited. Running the Discover OracleAS 
application updates the service map.

Discover OracleAS

Sets basic configuration properties needed for discovery.

Purpose

Launches the configuration editor allowing the OVO administrator to configure OAS SPI by 
setting initial configuration properties.

Function

Discover OracleAS does the following:

• Updates the configuration on the OVO management server and selected managed nodes.

Configuration information for all Oracle OC4J/OHS servers on all OVO managed nodes is 
maintained on the OVO management server. Configuration information for a specific Oracle 
OC4J/OHS server on an OVO managed node is maintained on that managed node (each 
managed node maintains a subset of the configuration information maintained on the OVO 
management server).

When saved, changes made with the configuration editor are always saved on the OVO 
management server.

An OVO managed node must be selected when this application is launched, and changes to 
the configuration affecting any Oracle OC4J/OHS servers on that managed node are 
automatically saved on that managed node.

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Configure OASSPI application, click Next from the 
configuration editor, and then click OK.
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If a specific OVO managed node is selected when this application is launched and changes are 
made that affect an Oracle OC4J/OHS server on a non-selected managed node, the changes 
are saved to the configuration on the OVO management server, but are not saved to the 
non-selected managed node. You must select the affected managed node, re-run this 
application, and, upon exiting the application, the changes are saved to the managed node.

To Launch Discover OracleAS

1  At the OVO console, select the node(s) in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Discover OracleAS. (If 
the above does not appear as described, select Map J Reload.)

4 The Introduction window opens. This window contains brief information about the 
Discover OracleAS application.

Click Next to start the Discovery application.

5 The Confirm Operation window opens. Click OK. 

Init Non-Root

Updates the /var/opt/OV/bin/instrumentation/wasspi_oas_platdef.pm file and 
generates the wasspi_oas_sudoers configuration file on the selected managed node(s).

Purpose

Simplifies the configuration of a non-root HTTPS agent on a UNIX managed node (OVO 8.x 
only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x 
Only) on page 56 for all the steps necessary to configure a non-root HTTPS agent on a UNIX 
managed node.

Function

Init Non-Root does the following for the selected managed nodes:

1 Runs the wasspi_oas_perl -S wasspi_oas_makePlatdef -force command to set the 
proper SPI path configuration and updates the 
/var/opt/OV/bin/instrumentation/wasspi_oas_platdef.pm and 
wasspi_oas_platdef.prop files.

2 Generates the wasspi_oas_sudoers configuration file.

If you click Cancel and made changes to the configuration, those changes remain 
in the configuration on the management server. To make the changes to the 
selected managed nodes’ configuration, you must select those nodes in the Node 
Bank window, start the Discover OracleAS application, click Next from the 
configuration editor, and then click OK.
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To Launch Init Non-Root

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Init Non-Root. 

Self-Healing Info 

Collects data to be sent to your HP support representative.

Required Setup

If you are collecting data for a reproducible problem, do the following before running the 
Self-Healing Info application:

1 Run the Start Tracing application. Refer to Start/Stop Tracing on page 150 for more 
information.

2 Reproduce the problem.

Purpose

Allows the OVO administrator to collect data to be used by your HP support representative.

Function

Self-Healing Info does the following for all managed nodes:

• Runs and saves data using the Verify application (see Verify on page 151 for more 
information).

• Recursively lists all files in the following directories:

— <OV_AGT_DIR>/bin/OpC/ (DCE)

— <OV_AGT_DIR>/bin/OpC/instrumentation/ (HTTPS)

— <OV_AGT_DIR>/wasspi/oas/conf/

— <OV_AGT_DIR>/wasspi/oas/datalog/

— <OV_AGT_DIR>/wasspi/oas/history/

— <OV_AGT_DIR>/wasspi/oas/lib/

— <OV_AGT_DIR>/wasspi/oas/tmp/

• Copies the following files:

— <OV_AGT_DIR>/conf/OpC/le (DCE)

— <OV_AGT_DIR>/conf/OpC/msgi (DCE)

Your HP support contract entitles you to access cross-referenced information through the HP 
OpenView self-healing services web site (http://support.openview.hp.com/
self_healing.jsp), linking you to a database where similar information and subsequent 
problem solutions increase troubleshooting effectiveness. Refer to the HP OpenView Smart 
Plug-ins DVD Installation Guide for UNIX and the section covering Self-Healing Services for 
more details.
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— <OV_AGT_DIR>/conf/OpC/monitor (DCE)

— <OV_AGT_DIR>/conf/OpC/nodeinfo (DCE)

— <OV_AGT_DIR>/wasspi/oas/conf/version (DCE)

— <OV_AGT_DIR>/datafiles/policies/msgi (HTTPS)

• Runs the following commands:

— codautil -obj (DCE)

— codautil -status (DCE)

— codautil -dumpds OASSPI_METRICS (DCE)

— codautil -dumpds OASSPI_RPT_METRICS (DCE)

— ovcodautil -obj (HTTPS)

— ovcodautil -status (HTTPS)

— ovcodautil -dumpds OASSPI_METRICS (HTTPS)

— ovcodautil -dumpds OASSPI_RPT_METRICS (HTTPS)

Self-Healing Info does the following for the management server:

• Copies the following file

— /opt/OV/wasspi/oas/conf/SiteConfig

• Recursively lists all files in the following directory:

— /opt/OV/wasspi/oas/log/

Self-Healing Info does the following for Windows managed nodes:

• Recursively lists all files in the following directory:

— <OV_AGT_DIR>/wasspi/oas/log/

• Copies the following file:

— <OV_AGT_DIR>/conf/dsi2ddf/ddflbd.mwc

• Runs the following commands:

— wasspi_oas_perl.cmd -S wasspi_oas_spiapps collect_show

— wasspi_oas_perl.cmd -S wasspi_oas_ca -m 5 -x print=on

— wasspi_oas_perl.cmd -S wasspi_oas_ca -m 5 -x print=on -debug

— opcagt.exe - status (DCE)

— OvGetAA.exe -status (DCE)

— opctemplate.exe -l (DCE)

— opcagt.bat (HTTPS)

— ovconfget.exe (HTTPS)

— opctemplate.bat (HTTPS)

Self-Healing Info does the following for UNIX managed nodes:

• Recursively lists all files in the following directory:

— <OV_AGT_DIR>/wasspi/oas/log/

• Copies the following file:
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— <OV_AGT_DIR>/conf/dsi2ddf/ddflbd.rc

• Runs the following commands:

— wasspi_oas_perl -S wasspi_OAS SPIapps collect_show

— wasspi_oas_perl -S wasspi_oas_ca -m 5 -x print=on

— wasspi_oas_perl -S wasspi_oas_ca -m 5 -x print=on -debug

— wasspi_oas_osinfo

— ps -ef

— opcagt -status

— opctemplate -l (DCE)

where <OV_AGT_DIR> :

• on a UNIX managed node is: /var/opt/OV 

• on a Windows managed node: depends on the installation of the product 

The data is saved in the following file:

• on a UNIX managed node: /tmp/wasspi_oas_support.tar

• on a Windows managed node: wasspi_oas_support.zip in one of the following 
directories (the exact location is displayed):

— %TEMP%

— %TMP%

— %SystemDrive%\temp\

— C:\temp\

— %temp% if JAVA_HOME or SERVER<n>_JAVA_HOME is defined

— %temp%\wasspi_oas_support\

To Launch Self-Healing Info

1 At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Self-Healing Info. 

This file may be hidden on some Windows managed nodes. If you do not see the 
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click 
the View tab. Under Hidden files and folders, select Show hidden files and folders.
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Start/Stop Monitoring

Starts/stops the collection of metrics for one OC4J/OHS server or all OC4J/OHS servers on a 
managed node.

Purpose

Allows the OVO administrator to start or stop the OAS SPI from collecting metrics from an 
OC4J/OHS server.

These metrics generate alarms (when thresholds are exceeded) and are used to create reports 
(automatically or manually generated) and graphs. The reports and graphs are used to 
analyze trends in server usage, availability, and performance.

Typically, the OVO administrator would stop monitoring on a managed node if the node is not 
running for a known reason (for example, the node is down for maintenance). Stopping the 
monitoring prevents unnecessary alarms from being generated.

Run the Verify application to determine if monitoring is started or stopped. By default, 
monitoring is on.

Function

Start Monitoring starts the collection of metrics for one or all OC4J/OHS servers on a 
managed node.

Stop Monitoring stops the collection of metrics for one or all OC4J/OHS servers on a managed 
node.

To Launch Start/Stop Monitoring

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Start Monitoring or Stop 
Monitoring. 

Start/Stop Tracing

Starts/stops the tracing of the collection of metrics.

Purpose 

Starts/stops the tracing of the collection of metrics into a file. Run this application only when 
instructed by your HP support representative.

Run the Self-Healing Info application to collect the file(s) created by this tool as part of the 
data to be used by your HP support representative.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.
150 Appendix C



To Launch Start/Stop Tracing

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin and double-click Start 
Tracing or Stop Tracing. 

Verify

Verify that OAS SPI is properly installed on the server or managed node.

Purpose

Allows the OVO administrator to verify that the OAS SPI is properly installed on the server 
or managed node.

Function

Verify does the following for all managed nodes:

• Checks that the following directories exist:

— <OV_AGT_DIR>/wasspi/oas/conf/

— <OV_AGT_DIR>/wasspi/oas/datalog/

— <OV_AGT_DIR>/wasspi/oas/history/

— <OV_AGT_DIR>/wasspi/oas/lib/

— <OV_AGT_DIR>/wasspi/oas/log/

— <OV_AGT_DIR>/wasspi/oas/tmp/

• Checks that the following files exist:

— <OV_AGT_DIR>/wasspi/oas/conf/logSetup

— <OV_AGT_DIR>/wasspi/oas/conf/MetricMap

— <OV_AGT_DIR>/wasspi/oas/conf/OVTrace.tcf.on

— <OV_AGT_DIR>/wasspi/oas/conf/SiteConfig

— <OV_AGT_DIR>/wasspi/oas/conf/SPIConfigLogFiles

— <OV_AGT_DIR>/wasspi/oas/conf/version

— <OV_AGT_DIR>/wasspi/oas/lib/castor.jar

— <OV_AGT_DIR>/wasspi/oas/lib/GraphSP.xsl

— <OV_AGT_DIR>/wasspi/oas/lib/JspiCola.jar

— <OV_AGT_DIR>/wasspi/oas/lib/MetricMap.xsl

— <OV_AGT_DIR>/wasspi/oas/lib/SiteConfig

— <OV_AGT_DIR>/wasspi/oas/lib/xalan.jar

— <OV_AGT_DIR>/wasspi/oas/lib/xerces.jar

— <OVOAGT_CMDDIR>/ovtrc3.jar
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— <OVOAGT_CMDDIR>/SPI_DiscClient.ps

— <OVOAGT_CMDDIR>/spi_oas.xml

— <OVOAGT_CMDDIR>/wasspi_oas_DiscReg.txt

— <OVOAGT_CMDDIR>/wasspi_oas_platdef.pm

— <OVOAGT_CMDDIR>/wasspi_oas_platdef.prop

— <OVOAGT_CMDDIR>/wasspi_oas_shs_agent_install.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_input.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_server_install.xml

— <OVOAGT_CMDDIR>/wasspi_oas_shs_task.xml

— <OVOAGT_CMDDIR>/wasspi_oas_traceConfig.xml

— <OVOAGT_CMDDIR>/wasspi_oas_util.vbs

— <OVOAGT_CMDDIR>/wasspi_oas_xalan.jar

— <OVOAGT_CMDDIR>/wasspi_oas_xerces.jar

— <OVOAGT_CMDDIR>/xerces.jar

— <OVOAGT_MONDIR>/wasspi_oas_cat

— <OVOAGT_MONDIR>/wasspi_oas_makePlatdef

• Checks that the following files exist and the version is A.04 or higher:

— <OV_AGT_DIR>/wasspi/oas/conf/MBeanReports.dtd

— <OV_AGT_DIR>/wasspi/oas/conf/MBeanReports.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/MetricDefinitions.dtd

— <OV_AGT_DIR>/wasspi/oas/conf/ReportsHeader.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/ReportsUtil.xsl

— <OV_AGT_DIR>/wasspi/oas/conf/SPIConfig

— <OV_AGT_DIR>/wasspi/oas/lib/JSpiCola.jar

— <OVOAGT_CMDDIR>/wasspi_oas_admin

— <OVOAGT_CMDDIR>/wasspi_oas_discovery.pl

— <OVOAGT_CMDDIR>/wasspi_oas_spiapps

— <OVOAGT_MONDIR>/wasspi_oas_ca

— <OVOAGT_MONDIR>/wasspi_oas_configBasic

— <OVOAGT_MONDIR>/wasspi_oas_configCheck

— <OVOAGT_MONDIR>/wasspi_oas_configLogs

— <OVOAGT_MONDIR>/wasspi_oas_configPerf

— <OVOAGT_MONDIR>/wasspi_oas_files

— <OVOAGT_MONDIR>/wasspi_oas_le

— <OVOAGT_MONDIR>/wasspi_oas_lib.pl

— <OVOAGT_MONDIR>/wasspi_oas_logdata

— <OVOAGT_MONDIR>/wasspi_oas_trace.pm
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— <OVOAGT_MONDIR>/wasspi_oas_udmgraphs

Verify does the following for the management server:

• Checks that the following directories exist:

— /opt/OV/wasspi/oas/conf/

— /opt/OV/wasspi/oas/bin/

— /opt/OV/wasspi/oas/lib/

• Checks that the following files exist:

— /opt/OV/wasspi/oas/conf/SiteConfig

— /opt/OV/wasspi/oas/conf/SPIConfig

— /opt/OV/wasspi/oas/lib/JSpiCola.jar

— /opt/OV/wasspi/oas/lib/wasspi_config_gui.jar

— /opt/OV/wasspi/oas/lib/xalan.jar

— /opt/OV/wasspi/oas/lib/xerces.jar

— /opt/OV/wasspi/oas/lib/MetricDefinitions.dtd

— /opt/OV/wasspi/oas/lib/images/details.gif

— /opt/OV/wasspi/oas/lib/images/properties.gif

— /opt/OV/wasspi/oas/lib/images/OpenView.gif

— /opt/OV/wasspi/oas/lib/help/intro_configure.html

— /opt/OV/wasspi/oas/lib/help/intro_discover.html

— /opt/OV/wasspi/oas/lib/help/instruct_discover.html

— /opt/OV/newconfig/OVPM/VPI_GraphsOASSPI.txt

— /opt/OV/newconfig/OVPM/OASSPI_FormTemplate.txt

— /opt/OV/newconfig/OVPM/OASSPI_FrameTemplate.txt

— /opt/OV/OVPM/webapps/OVPM/OASSPI_Empty.htm

• Checks that the following files exist and the version is A.04 or higher:

— /opt/OV/wasspi/oas/bin/parseDefs.pl

— /opt/OV/wasspi/oas/bin/processWASSPIDiscovMsg.pl

— /opt/OV/wasspi/oas/bin/startOASConsole.pl

— /opt/OV/wasspi/oas/bin/updateMasterConfig.pl

— /opt/OV/wasspi/oas/bin/wasspi_getOpcNodes

— /opt/OV/wasspi/oas/bin/wasspi_oas_app_graphs

— /opt/OV/wasspi/oas/bin/wasspi_oas_editConfig

— /opt/OV/wasspi/oas/bin/wasspi_oas_makePlatdef

— /opt/OV/wasspi/oas/bin/wasspi_oas_optaction_graphs

— /opt/OV/wasspi/oas/bin/wasspi_oas_xterm

— /opt/OV/wasspi/oas/lib/wasspi_oas_serverLib.pm

Verify does the following for Windows managed nodes:
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• Checks that the following files exist:

— <OVOAGT_CMDDIR>/spi_oas.cmd

— <OVOAGT_CMDDIR>/spi_oas_runSHSCollector.cmd

— <OVOAGT_MONDIR>/wasspi_oas_opcagt.cmd

— <OVOAGT_MONDIR>/wasspi_oas_perl.cmd

• Checks that the following files exist and the version is A.04 or higher:

— <OVOAGT_CMDDIR>/wasspi_oas_util.vbs

— <OVOAGT_MONDIR>/wasspi_oas_config.cmd

— <OVOAGT_MONDIR>/wasspi_oas_readRegistryKeys.vbs

Verify does the following for UNIX managed nodes:

• Checks that the following files exist:

— <OVOAGT_CMDDIR>/spi_oas.sh

— <OVOAGT_CMDDIR>/spi_oas_runSHSCollector.sh

— <OVOAGT_MONDIR>/wasspi_oas_opcagt

— <OVOAGT_MONDIR>/wasspi_oas_setpath

• Checks that the following files exist and the version is A.04 or higher:

— <OVOAGT_CMDDIR>/wasspi_oas_installFile

— <OVOAGT_CMDDIR>/wasspi_oas_osinfo

— <OVOAGT_CMDDIR>/wasspi_oas_processLib.pl

— <OVOAGT_MONDIR>/wasspi_oas_config

— <OVOAGT_MONDIR>/wasspi_oas_perl

— <OVOAGT_MONDIR>/wasspi_oas_xterm (DCE)

• Checks that the following files exist and the version is A.01.30.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp.exe

— <OVOAGT_MONDIR>/ddfcomp_coda.exe

— <OVOAGT_MONDIR>/ddflog.exe.pl

— <OVOAGT_MONDIR>/ddflog_code.exe

— <OVOAGT_MONDIR>/ddfutil.exe

Verify does the following for Linux managed nodes:

• Checks that the following files exist and the version is A.01.30.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda

— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

Verify does the following for OSF managed nodes:

• Checks that the following files exist and the version is A.01.23.00 or higher:
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— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda

— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

Verify does the following for HP-UX, Solaris, AIX,and other UNIX managed nodes:

• Checks that the following files exist and the version is A.01.20.00 or higher:

— <OVOAGT_MONDIR>/ddfcomp

— <OVOAGT_MONDIR>/ddfcomp_coda

— <OVOAGT_MONDIR>/ddflog

— <OVOAGT_MONDIR>/ddflog_code

— <OVOAGT_MONDIR>/ddfutil

where <OV_AGT_DIR> is:

• on a UNIX managed node: /var/opt/OV 

• on a Windows managed node: depends on the installation of the product 

and <OVO_CMDDIR>:

• on a DCE managed node is: <OV_AGT_DIR>/bin/OpC/cmds

• on an HTTPS managed node is: <OV_AGT_DIR>/bin/instrumentation

and <OVO_MONDIR> :

• on a DCE managed node is: <OV_AGT_DIR>/bin/OpC/monitor

• on an HTTPS managed node is: <OV_AGT_DIR>/bin/instrumentation

To Launch Verify

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J Verify.

If the Verify application is successful, the following message appears:

Installation is clean
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View Error File

View the OAS SPI error log file.

Purpose

Allows the OVO administrator to view the contents of the error log file.

Function

View the contents of the OAS SPI error log file <OV_AGT_DIR>/wasspi/oas/log/errorlog 
where <OV_AGT_DIR> typically is:

• /var/opt/OV on UNIX managed nodes

• /Program Files/HP OpenView/Installed Packages/
{790 ...} on Windows managed nodes

To View Error File

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J View Error File. 

View Graphs

View OpenView Performance Manager (OVPM) graphs in a web browser. 

Required Setup

OVPM must be installed and you must edit the ovweb.conf file (see Task 1: Configure the 
Management Server to Launch your Web Browser on page 41 for more information) before 
this application can run successfully.

If you are using Netscape Navigator, use version 6.0 or higher. Do not use Netscape Navigator 
4.79 with this application.

Purpose

Allows the OVO administrator to view OAS SPI graphs in OVPM from the OVO console.

Function

Launches a web browser to display OAS SPI metric data in OVPM graphs. 

To Launch View Graphs

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OASSPI Admin J View Graphs. 
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OracleAS

The following applications are found in the OASSPI OracleAS application group.

Launch Oracle AS Console

Starts the Oracle Application Server Control Console, AggreSPY servlet, or Oracle Enterprise 
Manager Database Control from the OVO console.

Required Setup

You must edit the ovweb.conf file (see Task 1: Configure the Management Server to Launch 
your Web Browser on page 41 for more information) before this application can run 
successfully. 

OracleAS Enterprise Manager must be installed on the managed node in order to launch the 
Oracle Enterprise Manager Database Control. 

Purpose 

Allows the OVO administrator to bring up the Oracle Application Server Control Console, run 
the AggreSPY servlet, or bring up the Oracle Enterprise Manager Database Control from the 
OVO console. 

Function

Launch Oracle AS Console launches one of the following:

• Oracle Application Server Control Console - brings up the console in a web browser for an 
application server or all application servers on the selected node(s).

• AggreSPY - displays metrics for Oracle Application Server processes organized by areas 
(DMS spies and metric tables) allowing the OVO administrator to monitor performance of 
an OC4J/OHS server instance running on a managed node. Refer to the Oracle 
Application Server Performance Guide for more information about the AggreSPY servlet. 

• Oracle Enterprise Manager Database Control - launches the Oracle Enterprise Manager 
Database Control used to manage the Oracle Application Server Metadata Repository 
database. Refer to the Oracle Application Server Administrator’s Guide for more 
information about the Oracle Application Server Metadata Repository.

OracleAS Enterprise Manager must be installed on the managed node in order to launch 
the Oracle Enterprise Manager Database Control.

To Launch Launch OracleAS Console

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OracleAS J 
Launch OracleAS Console.

4 Select an option:

— 1 - Launch the Oracle Application Server Control Console
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— 2 - Launch AggreSPY

— 3 - Launch the Oracle Enterprise Manager Database Control (OracleAS Enterprise 
Manager must be installed on the managed node for this option to be available)

— q - Quit the application

Start/Stop OracleAS

Starts/stops Oracle Application Servers from the OVO console.

Required Setup

The START_CMD, STOP_CMD, and USER configuration properties MUST be set before this 
tool can run successfully.

Purpose 

Allows the OVO administrator to start and stop Oracle Application Servers from the OVO 
console. The OVO administrator can start and stop an application server or all application 
servers on the selected managed node(s) and does not have to log in to each Oracle Application 
Server Control Console to perform these functions.

Function

Start/Stop OracleAS starts or stops an application server or all application servers on the 
selected managed node(s).

To Launch Start/Stop OracleAS

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OracleAS J 
Start OracleAS or Stop OracleAS. 

View OAS Logs

View the Oracle Application Server log files.

Purpose 

Allows the OVO administrator to select an Oracle Application Server log file to view without 
having to log in to the system on which the Oracle Application Server is running.

Function

View OAS Logs does the following:

• When View OAS Logs is run without entering a parameter, a numbered list of available 
log files for a managed node is presented.
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• When View OAS Logs is run with a parameter entered, if the parameter is not valid (a 
non-numeric value is entered or the number entered does not correspond to the list of 
available log files), a numbered list of available log files for the managed node is 
presented.

• When View OAS Logs is run with a valid parameter, the contents of the corresponding log 
file for the managed node is presented.

You may only enter one numeric value in the parameter field. This is the number used to 
designate the log file to view for all managed nodes selected. Select one log file per managed 
node to view each time you launch the application.

If you keep the Application Status window open and re-launch the application, the output in 
the Application Status window accumulates.

To Launch View OAS Logs

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OracleAS J 
View OAS Logs.

4 Select the managed nodes on which you want to view the Oracle Application Server log 
file.

5 Click Launch. The Edit Parameters window appears. If you know the number of the log file 
you want to view, enter it into the Parameters field. Otherwise, leave this field blank to 
list available log files to view.

6 Click Launch. The Application Status window opens.

7 In the Launched Applications field, check the Status of the application for each node:

• Started/Starting - The application is running.

• Succeeded - A list of available log files to view opens. Select the node in the Launched 
Applications field and scroll through the Application Output field to view the list of 
available log files.

• Failed - The tool did not succeed. Select the node in the Launched Applications field 
and scroll through the Application Output field for more information about the 
problem.

8 Double-click View OAS Logs.

9 Select the managed nodes on which you want to view the Oracle Application Server log 
file.

10 Click Launch. The Edit Parameters window appears.

11 In the Parameters text box, enter the number of the log file you want to view. Only one log 
file can be selected.

If you do not remember the number of the log file, go to the Application Status window, 
select the node in the Launched Applications field, scroll through the Application Output 
filed to view the list of available log files, and enter the number of the log file you want to 
view in the Edit Parameters window.

12 Click Launch.

13 In the Application Status window, select the node on which to view the selected log file 
and scroll through the Application Output filed to view the log file.
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14 Repeat steps 8-13 for each log file you want to view.

15 Click Close to close the Application Status window.

View Status

Displays a status report for the Oracle Application Server(s) on the selected managed node(s).

Purpose 

Allows the OVO administrator to quickly check the status of each application server running 
on a managed node. 

Function

View Status displays the Oracle Application Server instance name, hostname, Oracle home, 
and processes (component, type, process ID, and status) for each application server instance.

To Launch View Status

1  At the OVO console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window select OASSPI J OracleAS J View Status. 
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Glossary
agent

A program or process running on a remote device or computer system that responds to 
management requests, performs management operations, or sends performance and event 
notification. An agent can provide access to managed objects and MIB variables, interpret 
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related 
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but 
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is executed in response to an event, message, or a 
change in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service 
from another computer (server). When the context is software, a program or executable 
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs 
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out. 
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that 
make up the network. For example the components of a network may include computer 
systems, routers, switches, hubs, operating systems and network software. The configuration 
of the network determines the way that it works and the way that it is used. In a software 
context, the combination of settings of software parameters and attributes that determine the 
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a 
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified 
environment, application or usage. 

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of 
applications.

customization

The process of designing, constructing or modifying software to meet the needs and 
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular 
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically 
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the 
business environment.

Deployed application

An application and its components that have been installed and started to work in the 
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that 
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.
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event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated 
by an agent or process in a managed object or by a user action. Events usually indicate a 
change in the state of a managed object or cause an action to occur. 

HP OpenView

A family of network and system management products, and an architecture for those 
products. HP OpenView includes development environments and a wide variety of 
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure. 

icon

An on-screen image that represents objects that can be monitored or manipulated by the user 
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status 
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application 
or set of management applications. The console may be on the system that contains the 
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to 
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of 
one or more events relative to specified conditions, or a change in application, system, 
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an 
event, the evaluation of one or more events relative to specified conditions or a change in 
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from 
particular events.The string summarizes the important characteristics of the event. Message 
keys can be used to allow messages to acknowledge other messages, and allows for the 
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that 
initiated the message. See also severity level.

metadata

Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT 
environments. Management products are added or "snapped into" the management console 
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the 
presentation of a specific type of data. Modules can interact with one another and with other 
software.

node

When the context is network, a computer system or device (for example, printer, router, 
bridge) in a network. When the context is a graphical point to point layout, a graphical 
element in a drawing that acts as a junction or connection point for other graphical elements.

OVO

HP OpenView Operations

OVPA

HP OpenView Performance Agent

OVPM

HP OpenView Performance Manager

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of 
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data 
that is valid for the parameter. For example a parameter type could be IP Address which 
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indicates that parameter values must have 4 numbers separated by decimals with the value 
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policy

A set of one or more specifications rules and other information that help automate network, 
system, service, and process management. Policies can be deployed to various targets (for 
example, managed systems, devices, network interfaces) providing consistent, automated 
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying, 
deleting) for the purposes of network, system or service management.

policy type

An abstraction or categorization of policies based on the function of the policy or the services 
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device. 
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for 
example, management capabilities, file storage capabilities) to other computer systems 
(clients) on the network. If the context is a software component, a program or executable 
process that responds to and services requests issued by clients.

severity level

A property of an object indicating the status of the object. Severity level is based on the impact 
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management 
capabilities specific to a given type of business application, database, operating system, or 
service.

trace log

An output file containing records of the execution of application software
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setting, 45

configuration
properties, 135
structure, 125
syntax, 125

configuration editor
 See Configure OASSPI application

configuration example
group and node properties, 141
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Configuration tree item, 128
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Configure OASSPI application, 18, 144
actions, 129
Add Group action, 129, 131
Add Node action, 129, 131
Add OC4J/OHS Server action, 129, 130
Application Servers tree item, 128
buttons, 129
Cancel button, 129
Configuration tree item, 128
Default Properties tree item, 128
Defaults tree item, 128
Exit action, 130
Finish button, 129
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how to run, 144
icons, 127
Next button, 129
Nodes tree item, 128
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using, 127
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configuring
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customization, 14

customizing
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D
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Discover OracleAS application, 18, 42, 145
how to run, 146
what it does, 145

discovery process
verifying, 43

discovery template, 21
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templates, 43

duration
customizing, 50

E
editing
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error messages, 89 to 121

Exit action, 130

F
files, locations on management server/managed 

nodes, 80, 82

filesets, 23

Finish button, 129

G
global properties, 125

GRAPH_URL property, 138
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date range, 70
example, 67
generating, 70
metrics used to generate, 69
operator action, 70
OVPM, 63
viewing alarm conditions, 68
viewing conditions, 69

GROUP block, 125

Groups tree item, 128

H
HOME property, 138

I
Init Non-Root application, 18, 146

how to run, 147
what it does, 146
168



installing, 23
bundles, 23
filesets, 23
OAS SPI report package, 65
swinstall, 23

instruction text
location, 15

J
JAVA_HOME property, 138

L
Launch Oracle AS Console application, 19, 157

how to run, 157
required setup, 157
what it does, 157

license count, 62

logfiles templates, 21

M
managed nodes

adding to OAS SPI node group, 42
configuring, 38

management server
configuring, 39

manually generated reports, 59

MAX_ERROR_LOG_SIZE property, 138

messages
instruction text, 15
message browser, 15

message template, 21

message text
customizing, 50
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data collected, 13
graphs generated from, 69
reports generated from, 65

metrics templates, 21

modifying
alarms, 51
templates, 50

monitors
distributing, 41

N
NAME property, 139

Next button, 129

NODE block, 126

Nodes tree item, 128

O
OAS SPI

components, 17
overview, 14

OASSPI Admin application group, 18

OASSPI-Discovery template, 21

OASSPI-Logfiles template group, 21

OASSPI-Messages template, 21

OASSPI-Metrics template group, 21

OAS SPI node group
adding nodes, 42

OAS SPI Reports application group, 19

OASSPI-Schedule template group, 21

operator
assigning responsibilities, 26, 34

operator-initiated actions, 51

OracleAS application group, 18

ov.envvars.sh, 33

OV_CONF environment variable, 33

OVPA, 63

OVPM
integrating with OAS SPI, 33, 67

ovweb.conf
configuring, 33
OV_CONF environment variable, 33

P
prerequisites

configuring, 33

properties, 135
configuring conditional, 44
definitions, 137 to 140
global, 125
precedence, 126
server-specific, 126
setting conditional, 45

R
reinstalling

templates, 58

Remove ALL Groups action, 130, 132

Remove All Nodes action, 130, 133

Remove ALL OC4J/OHS Servers action, 130, 132

Remove Group action, 130, 132
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Remove Node action, 130, 133

Remove OC4J/OHS Server action, 130, 132

removing
OAS SPI, 30
swremove, 24

Reporter
integrating with OAS SPI, 65

Reporter reports, 65

report package
installing, 29, 32, 65

reports
application bank, 59
application bank generated, 58
automatic action, 58
automatically generated, 59
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included, 16
manually generated, 59
metrics used to generate, 65
Reporter, 63, 65
viewing, 59

reports (automatic action)
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RMID_PORT property, 139

RMID_START_TIME property, 139

S
Save action, 130

Save button, 129

schedule templates, 21

Self-Healing Info application, 18, 147
how to run, 149
required setup, 147
what it does, 147

server-specific properties, 126

Set Configuration Properties tab, 130, 133

Set Configuration Settings tab
AUTO_DISCOVER, 134
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setting a property, 133

setting
conditional properties, 45

severity
customizing, 50

START_CMD property, 139

Start Monitoring application, 18, 150
how to run, 150
what it does, 150

Start OracleAS application, 19, 158
how to run, 158
required setup, 158
what it does, 158

Start Tracing application, 18, 150
how to run, 151
what it does, 150

status of application server
verifying, 38

STOP_CMD property, 140

Stop Monitoring application, 18, 150
how to run, 150
what it does, 150

Stop OracleAS application, 19, 158
how to run, 158
required setup, 158
what it does, 158

Stop Tracing application, 18, 150
how to run, 151
what it does, 150

structure
configuration, 125

swinstall, 23
reinstalling templates, 58

swremove, 24

syntax
configuration, 125

T
tag option

creating custom template groups, 56

template groups, 20
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customizing, 56
OASSPI-Logfiles, 21
OASSPI-Metrics, 21
OASSPI-Schedule, 21
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collector, 21
continuously setting, 52
customizing, 49
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distributing, 43
logfiles, 21
message, 21
metrics, 21
modifying, 50
OASSPI-Discovery, 21
OASSPI-Messages, 21
reinstalling, 58
resetting thresholds, 52
schedule, 21
thresholds without reset, 52

thresholds
customizing, 50
resetting, 52
settings for different servers, 55
without reset, 52

TIMEOUT property, 140

TYPE property, 140

U
upgrading, 24

management server, 25
OAS SPI graph package, 29
OAS SPI report package, 29, 32

user defined metrics
graphing, 78

USER property, 140

using
Configure OASSPI application, 127

V
Verify application, 18, 151

how to run, 155
what it does, 151

verifying
application server status, 38
discovery process, 43

VERSION property, 140

View Configuration Settings tab, 130, 134
View Inherited Properties, 135

View Error File application, 18, 156
how to run, 156
what it does, 156

View Graphs application, 18, 156
how to run, 156
required setup, 156
what it does, 156

viewing
reports, 59

View Inherited Properties, 135

View OAS Logs application, 19, 158
how to run, 159
what it does, 158

View Status application, 19, 160
how to run, 160
what it does, 160
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parameters, 53
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